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Chapter 1   Introduction
1.1 Overview

The MultiMode PicoForce (see Figure 1.1a) is an instrument designed for the ultra-sensitive 
measurement of very small forces. The measurable range of forces is approximately between 1 
piconewton (pN) and 10 millinewtons, an extraordinary ten orders of magnitude. This range of 
forces includes, at the high end, the forces required to deform advanced materials (polymers, 
composites, ceramics) at the nano- and micro-meter scale. The middle of the range includes 
important forces such as those required to bend biological membranes and fundamental 
intermolecular interactions such as electrostatic and Van der Waals forces. Some of the most 
interesting possibilities, however, exist within the lower 10-500 piconewton range of the 
instrument. This range encompasses such exciting and important forces as those that hold proteins 
together (see Figure 1.1b), those that bind antibodies to their corresponding antigens, those that 
attract drugs to their targets, and a host of other forces in the biological world. The analysis of 
forces in this lower range has been dubbed force spectroscopy by Dr. Hermann Gaub, a leader in 
this field of research.

Figure 1.1a   PicoForce Control Module, PicoAngler and MultiMode Scanning Probe Microscope (SPM)
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Figure 1.1b   MultiMode PicoForce Stretching a Molecule 

The MultiMode PicoForce achieves this incredible sensitivity and range by sensing the deflection 
of a micro-machined cantilever with an optical beam detector. The cantilevers can be manufactured 
with various spring constants, starting at less than 10pN/nm. This means that a force of ten 
piconewtons at the end of the cantilever bends the lever one nanometer from its resting position. 
Deflections in this range are easily quantifiable with the optical lever detection method (see Figure 
1.1c). The cantilever includes an ultra-sharp (<30nm radius) tip at its end that interacts either 
directly with the sample or via some chemical functionalization. This technology is very similar to 
that employed in conventional Atomic Force Microscopes (AFMs) and more generally in Scanning 
Probe Microscopes (SPMs). In fact, researchers have used existing SPM/AFM systems for much of 
the work published so far in the field of force spectroscopy. However, for various reasons, the 
existing commercial SPM/AFM hardware is not well suited to these measurements. The 
MultiMode PicoForce addresses these deficiencies and hence provides the ideal instrument with 
which to investigate piconewton scale interactions.

Figure 1.1c   The Optical Lever Detection Method
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Tip

  Photodetector
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Introduction
Scope of this Document
The forces measured may be either attractive (pulling the tip down) or repulsive (pushing the tip 
up). These forces may occur as the tip-sample distance is increased or decreased. The ability to 
precisely and reproducibly control tip-sample separation is one key feature of the MultiMode 
PicoForce. In brief, the tip-sample separation is controlled with a piezoelectric device with 20 
microns (µm) of range. Piezoelectric devices are manufactured from materials that expand and 
contract with variation of the voltage applied across them. Since the response of piezoelectric 
devices is not inherently linear or constant, a sensor is included for measuring the actual 
displacement in the Z-axis with a precision better than 0.5nm. The capacitive sensor design takes 
advantage of the fact that the capacitance between two parallel plates varies inversely with 
separation distance. The sensor is included in an ultra-fast feedback loop that ensures that the Z-
axis moves the desired distance at the specified speed.

Tip-sample separation and data acquisition are controlled with a custom software graphical user 
interface (GUI) written in the Microsoft Windows environment. This GUI enables researchers to 
measure forces in response to automated control of tip-sample separation, to measure forces 
associated with complex user-scripted tip-sample separation profiles, and to measure forces 
encountered while controlling the tip-sample separation manually with a novel, tactile-feedback 
device, the PicoAngler.

The PicoAngler includes a knob that controls the tip-sample separation with four levels of 
sensitivity. The knob incorporates a variable torque device that amplifies the tip-sample force by a 
variable gain of roughly ten billion. This extremely high gain on the real-time tactile-feedback 
device allows researchers to actually feel the forces involved as proteins unfold and antibodies 
unbind. In addition to its usefulness in mapping out these forces, the PicoAngler provides 
researchers with a truly new (patent pending), unique, and exciting perspective on their 
measurements.

In addition to controlling tip-sample separation, the MultiMode PicoForce allows the tip to be 
moved in the X-Y plane relative to the sample with a range greater than 40m square. This allows 
precise positioning of the tip for force measurements and also allows the MultiMode PicoForce to 
be used for standard SPM/AFM imaging modes. It is the very first commercial instrument in its 
class to include both precise force measurement capabilities and X-Y scanning capabilities.

These capabilities can be brought to bear on a variety of samples in the fields of biology, 
biophysics, physics, materials science, and chemistry. Samples can be investigated in their 
appropriate, native environments, including controlled gas atmospheres, biological buffers and 
other liquids.

1.2 Scope of this Document

This MultiMode PicoForce Manual details the use of the MultiMode PicoForce Option on an SPM. 
The MultiMode may be operated by a NanoScope IIIa (NSIIIa) Controller in conjunction with an 
Extender Electronics Module or Quadrex, or operated by a NanoScope IV (NSIV) or NanoScope V 
Controller (with Quadrex built-in). Refer to Support Note 322, Quadrex for discussion of the 
Quadrex module. Refer to the NanoScope IV or V Controller Manual for discussion of Quadrex 
features for SPMs operated by NanoScope IV or V Controllers. Quadrex capabilities are identical 
for phase-equipped SPMs, regardless of which controller is used.
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For specifics of your SPM, refer to its accompanying MultiMode Scanning Probe Microscope 
Instruction Manual. For coverage of all software commands and details of the various modes of 
operation (Realtime, Offline, Image, Scope, Force, etc.), refer to the Command Reference Manual 
and/or the NanoScope Software 7 User Guide. Similarly, add-on modules, sensors, and even areas 
of investigation (such as electrochemistry) are introduced in Support Notes and Application Notes. 
Programmable aspects of NanoScope software applicable even to SPM systems without robotic 
sample loading are described in the Automation Supplement. The Scanning Probe Microscopy 
Training Notebook is a compact introduction for getting started on MultiMode and Dimension 
SPMs.

1.3 Conventions

• In the interest of clarity, certain nomenclature is preferred. An SPM probe is comprised 
of a tip affixed to a cantilever mounted on a substrate, which is inserted in a probe 
holder.

• Three font styles distinguish among contexts. For example:
Window or Menu Item > BUTTON OR PARAMETER NAME is set to VALUE. 

• A phase-equipped SPM implies that an SPM has the required modification to perform 
PhaseImaging in any of the following configurations:

• NSIIIa Controller and Quadrex module

• NSIIIa Controller and Extender Electronics Module

• NSIV Controller

• NSV Controller

                   A phase-equipped SPM may also be referred to as extended, or equipped for Quadrex,
                   or equipped for Extender Electronics.

• In pre-Version 6 NanoScope software, the Control Monitor is generally used for 
providing access to control parameters and the Display Monitor for displaying scanned 
images or other results (e.g., sweep curves).

• Software buttons are labelled with options available. For instance, if the Strip Chart 
Controls START button has been clicked, then the system is in Strip Chart Controls 
Mode and the same button is now labelled STOP, the remaining option available: to exit 
the mode.
MultiMode PicoForce Manual Rev. F
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Chapter 2   Safety
This section summarizes safety precautions to observe when installing and operating a Picoforce 
spectroscopy-capable MultiMode SPM. Additional cautions need to be observed when operating 
the MultiMode SPM, a component of MultiMode PicoForce; refer to the MultiMode Scanning 
Probe Microscopy Instruction Manual.

WARNING: Use MultiMode PicoForce equipment only as specified in this 
manual and as specified in any documentation associated with its 
components. Any use of the equipment in an unspecified manner is 
strongly discouraged and may result in damage or injury as 
cautioned by signed warnings in this chapter and throughout the 
documentation.
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Table 2.0a   Safety Symbols Key

 

Symbol Definition

This symbol identifies conditions or practices that could 
result in damage to the equipment or other property, and 
in extreme cases, possible personal injury.

Ce symbole indique des conditions d'emploi ou des 
actions pouvant endommager les équipements ou acces-
soires, et qui, dans les cas extrêmes, peuvent conduire à 
des dommages corporels.

Dieses Symbol beschreibt Zustände oder Handlungen die 
das Gerät oder andere Gegenstände beschädigen können 
und in Extremfällen zu Verletzungen führen können.

This symbol identifies conditions or practices that involve 
potential electric shock hazard.

Ce symbole indique des conditions d'emploi ou des 
actions comportant un risque de choc électrique.

Dieses Symbol beschreibt Zustaende oder Handlungen 
die einen elekrischen Schock verursachen koennen.

This symbol identifies a laser hazard. Exposure could 
result in eye damage.

Ce symbole indique un risque lié à un laser. Une exposi-
tion à ce laser peut entraîner des blessures aux yeux.

Dieses Symbol bedeutet “Gefährliche Laserstrahlung”. 
Laserstrahlung kann zu Beschädigung der Augen führen.

WARNING: Service and adjustments should be performed only by qualified 
personnel who are aware of the hazards involved.

AVERTISSEMENT:Tout entretien ou réparation doit être effectué par des personnes 
qualifiées et conscientes des dangers qui peuvent y être associés.

WARNUNG: Service- und Einstellarbeiten sollten nur von qualifizierten 
Personen, die sich der auftretenden Gefahren bewußt sind, 
durchgeführt werden.
MultiMode PicoForce Manual Rev. F



Safety
WARNING: Follow company and government safety regulations. Keep 
unauthorized personnel out of the area when working on 
equipment.

AVERTISSEMENT:Il est impératif de suivre les prérogatives imposées tant au niveau 
gouvernmental qu’au niveau des entreprises. Les personnes non 
autorisées ne peuvent rester près du système lorsque celui-ci 
fonctionne.

WARNUNG: Befolgen Sie die gesetzlichen Sicherheitsbestimmungen Ihres 
Landes. Halten Sie nicht authorisierte Personen während des 
Betriebs vom Gerät fern.

WARNING: Voltages supplied to and within certain areas of the system are 
potentially dangerous and can cause injury to personnel. Power-
down everything and unplug from sources of power before doing 
ANY electrical servicing. (Bruker personnel, only).

AVERTISSEMENT:Les tensions utilisées dans le système sont potentiellement 
dangereuses et peuvent blesser les utilisateurs. Avant toute 
intervention électrique, ne pas oublier de débrancher le système. 
(Réservé au personnel de Bruker seulement).

WARNUNG: Die elektrischen Spannungen, die dem System zugeführt werden, 
sowie Spannungen im System selbst sind potentiell gefährlich und 
können zu Verletzungen von Personen führen. Bevor elektrische 
Servicearbeiten irgendwelcher Art durchgeführt werden ist das 
System auszuschalten und vom Netz zu trennen. (Nur Bruker 
Personal).
Rev. F MultiMode PicoForce Manual 7
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DANGER: Use of controls or adjustments or performance of 
procedures other than those specified herein may result 
in hazardous laser light exposure. The use of optical 
instruments with this product increases eye hazard.

DANGER: Toute utilisation, ou étalonnage ou essai de 
modification, autre que ci-dessous décrits, peut entraîner 
une exposition dangereuse à la lumière du laser. 
L’utilisation de systèmes optiques avec ce produit peut 
entraîner un danger pour les yeux.

GEFAHR: Die falsche Verwendung dieses Gerätes mit nicht in 
diesem Handbuch beschriebenen Vorgehensweisen 
kann gefährliche Laserstrahlung freisetzen. Optische 
Instrumente, die zusammen mit diesem Produkt 
verwendet werden, können evtl. Augenschäden 
hervorrufen und verstärken.
MultiMode PicoForce Manual Rev. F



Chapter 3   Installation: PicoForce on a New 
MultiMode System
This chapter includes a list of MultiMode PicoForce system components, including those that 
comprise a MultiMode system (see System Components, page 11).

Note: If you are not sure if you want to upgrade an existing MultiMode system, see 
Chapter 4, Installation: Upgrade to PicoForce, for detail as to which 
components require upgrade.

3.1 Unpacking MultiMode PicoForce System Components

A MultiMode PicoForce system is typically shipped in more than one crate.

The PicoForce-specific components are packed together in one crate, see Figure 3.1a. Carefully 
unpack the components from their crates.

Provide the proper environmental conditions (see Table 3.1a) for system operation and storage.

Table 3.1a   Environmental Requirements

CAUTION: Do not store the equipment outside, even in a dry weather location.

CAUTION: Handle sensitive electronics with care. Avoid dropping or bumping 
the NanoScope Controller and PicoForce Control Module, especially 
the PicoForce scanner, and especially outside the shipping crate(s).

Equipment Use Condition Requirement

Operation Temperature 15ºC (59ºF) to 35ºC (95ºF)

" Relative Humidity 45% to 80%, non-condensing

Storage Temperature 10ºC (50ºF) to 50ºC (122ºF)

" Relative Humidity 35% to 90%, non-condensing
Rev. F MultiMode PicoForce Manual 9
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Figure 3.1a   Packaged PicoForce Option Components: a) Top Layer, b) Bottom Layer 

CAUTION: Do not obstruct the ventilation slots of either the NanoScope 
controller or the PicoForce Control Module.

a)

b)
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Installation: PicoForce on a New MultiMode System
System Components
3.2 System Components

A MultiMode PicoForce system can be purchased as an upgrade to the MultiMode SPM; its 
minimum component list:

• Low Noise MultiMode SPM head (see Figure 3.2a), a required upgrade

Figure 3.2a   A MultiMode SPM Head

• MultiMode SPM scanner stabilizing screw

• MultiMode SPM scanner parameter files (hardcopy, softcopy if sold with computer)

Note: Find calibrated scanner parameter files in the hard disk EQUIP directory.

• Scanner calibration reference samples: XYZ, 3µm3µm, 180nm vertical

• Calibration Standard Application Note

• A closed-loop Z-axis “PF” vertical engage scanner (see Figure 3.2b)

• Storage box for PicoForce scanner

• PicoForce Probes Model MLCT-AUNM
Rev. F MultiMode PicoForce Manual 11
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Figure 3.2b   PicoForce Closed Loop Z MultiMode “PF” Vertical Engage Scanner

• A PicoForce Control Module

• A PicoAngler with cable to the PicoForce Control Module

• Cantilever Holder for Scanning in Fluid (TappingMode). Also referred to as a tapping 
fluid cell, model MTFML

• A compound cable between the MultiMode base and PicoForce Control Module (see 
Figure 3.2f, cable “A”)

• A cable between the PicoForce Force Spectroscopy Control Module and Extender, or 
Quadrex, Module with 37 pin connectors (see Figure 3.2f, cable “B”)

• A 9-pin serial cable between the PicoForce Control Module and the computer (see 
Figure 3.2f, cable “D”)

• PicoForce Sensor Module Jumper (only used with NanoScope IV Controller or 
Quadrex)

• PicoForce Passband gain Dongle (not included with the NanoScope V Controller)

• Picoforce Deflection Gain Dongle (not included with the NanoScope V Controller)

• This MultiMode PicoForce Manual.

• PicoForce Thermal Tune Procedure Note

Additional compatible options that may be purchased with a MultiMode PicoForce system:

• Enhanced optical top viewing system, either: optical microscope (OM), OMV (video, 
see Figure 3.2c), CCD only, or CCD plus OM

• vibration isolation with tripod (TRV1) or table (VT-102)
MultiMode PicoForce Manual Rev. F



Installation: PicoForce on a New MultiMode System
System Components
The MultiMode PicoForce Option for the MultiMode requires a NanoScope IIIa Controller and 
either an Extender Electronics Module or a Quadrex module, a NanoScope IV or V Controller 
(with Quadrex built-in). The Extender and Quadrex monitor cantilever vibration phase with respect 
to the driving force of the tapping oscillator in TappingMode, enabling PhaseImaging.

See the MultiMode Scanning Probe Microscope Instruction Manual for system components 
included with the MultiMode SPM.

Figure 3.2c   The MulitMode PicoForce System with Optional OMV Video Optics

3.2.1 Hardware Configuration

One recommended system layout is shown in Figure 3.2c. Refer to the installation instructions in 
the MultiMode SPM Instruction Manual as required in addition to the following configuration and 
cabling guidelines. Once you have the computer and controller cabled (including cable E), make 
the PicoForce Option connections with cables A, B, C and D as shown in Figure 3.2f, selecting the 
configuration option based on whether the system includes an NSIIIa Controller with the Extender 
Electronics Module (option 2), an NSIIIa Controller with Quadrex (option 3), an NSIV or NSV 
Controller with built-in Quadrex (option 1). Cable A has a 37 pin and a 15 pin connector at the 
PicoForce Force Spectroscopy Control Module end (see Figure 3.2e) and a 25 pin connector with a 
smaller embedded 9 pin connector (to the scanner) at the MultiMode end (see Figure 3.2d); cables 
B and C are identical and have 37 pin connectors at both ends. Cable D is a 9 conductor serial port 
Rev. F MultiMode PicoForce Manual 13
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cable. Cable E is a 25 conductor parallel port cable. The labels on the mating connectors on the 
instruments are listed in Table 3.2a (option 1), Table 3.2b (option 2) and Table 3.2c (option 3).

Note: Additional cables from the computer to other peripherals are not shown here. 
These are configured by Bruker personnel during installation and are 
associated with specific serial port assignments.

Figure 3.2d   Cable A Between the MultiMode SPM and the PicoForce Control Module

Figure 3.2e   Connectors on the Back Panel of the PicoForce Control Module

    Connect to 
MultiMode Base.

   Connect both to 
  PicoForce Control
 Module back panel.
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Figure 3.2f   MultiMode PicoForce System Interconnection Options

Table 3.2a   Option 1: PicoForce Cabling with NSIV(a) or NSV

Cable Location Connector Label

A (25 pin) MultiMode SPM unlabeled (on the base of the SPM)

A (37 pin) PicoForce Control Module Microscope

A (15 pin) PicoForce Control Module PF Scanner

B (37 pin) PicoForce Control Module Nanoscope Controller

B NSIV To Microscope (back of NSIV)

D (9 pin) Computer A COM port

D PicoForce Control Module Computer

E (25 pin) NSIV To Computer (back, middle)

E Computer To Nanoscope Controller
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Installation: PicoForce on a New MultiMode System
System Components

16
Table 3.2b   Option 2: PicoForce Cabling with NSIIIa and Extender

Table 3.2c   Option 3: PicoForce Cabling with NSIIIa and Quadrex

MultiMode PicoForce requires a terminated connector, the PicoForce Sensor Module Jumper (a 
“dongle”) with Quadrex-capable NS IIIa or NSIV(a) systems. When operating the PicoForce 
Option, connect the Sensor Module Jumper (see Figure 3.2g) to the 15-pin SENSOR MOD. 
connector (see Figure 3.2h) on the back of the NSIV(a) Controller (which includes Quadrex) or to 
the APPLICATIONS MODULES connector (see Figure 3.2i) on the back of the Quadrex Module 
(used with an NSIIIA Controller).

Note: PicoForce will operate without the jumper. However, the Z sensor data channel 
will be disconnected.

Cable Location Connector Label

A (25 pin) MultiMode SPM unlabeled (on the base of the SPM)

A (37 pin) PicoForce Control Module Microscope

A (15 pin) PicoForce Control Module PF Scanner

B (37 pin) PicoForce Control Module Nanoscope Controller

B Extender To Microscope

C (37 pin) Extender To NanoScope

C NSIIIa unlabeled (front of NSIIIa)

D (9 pin) Computer A COM port

D PicoForce Control Module Computer

E (25 pin) NSIIIa To Computer (back, top, right)

E Computer To Nanoscope Controller

Cable Location Connector Label

A (25 pin) MultiMode SPM unlabeled (on the base of the SPM)

A (37 pin) PicoForce Control Module Microscope

A (15 pin) PicoForce Control Module PF Scanner

B (37 pin) PicoForce Control Module Nanoscope Controller

B Quadrex To Microscope

C (37 pin) Quadrex To NanoScope

C NSIIIa unlabeled (front of NSIIIa)

D (9 pin) Computer A COM port

D PicoForce Control Module Computer

E (25 pin) NSIIIa To Computer (back, top, right)

E Computer To Nanoscope Controller
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Installation: PicoForce on a New MultiMode System
Important: Powering Sequence
Figure 3.2g   The PicoForce Sensor Module Jumper

Figure 3.2h   Close-Up of Connectors, Back of the NanoScope IV Controller

Figure 3.2i   Close-Up of Connectors, Back of the Quadrex Module

3.3 Important: Powering Sequence

When the unpowered hardware is configured:

1.  Attach their power cords to the computer and NanoScope controller, then connect these to 
appropriate power outlets. 
Rev. F MultiMode PicoForce Manual 17
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Note: Ensure that the NanoScope Controller, PicoForce Controller and computer are 
powered by the same outlet to avoid ground loops. Ground loops have been 
shown to increase noise.

2. Attach the power cord to the connector at the left of the back panel of the PicoForce Control 
Module (see Figure 5.2a). 

3. Verify the available power matches the ratings specified on the PicoForce Control Module 
back panel (see Table 13.2b) and the fuses installed (see Table 13.2a). 

4. Connect the other end of the same power cord to a wall outlet. Always supply and remove 
power from components in the correct order.

Note: If the computer is turned off, the NanoScope controller must also be 
unpowered.

Power on sequence:     1) computer
                                     2) NanoScope controller
                                     3) PicoForce Control Module

Power off sequence:    1) PicoForce Control Module
                                     2) NanoScope controller
                                     3) computer

Proceed to Chapter 5, Hardware Orientation, for an introduction to the PicoForce Control 
Module.

CAUTION: Never supply power to the NanoScope Controller and PicoForce 
Control Module unless the computer is already running.
MultiMode PicoForce Manual Rev. F



Chapter 4   Installation: Upgrade to PicoForce
4.1 Existing System Component Upgrades

An existing MultiMode SPM system may be upgraded to include the PicoForce Option (see 
System Components, page 11, for both MultiMode and PicoForce-specific components).

Note: Contact Bruker (either your local representative or 805 967 1400) for assistance 
evaluating an existing MultiMode SPM system for upgrade to MultiMode 
PicoForce and/or for coordination of the installation.

The flow chart in Figure 4.1a outlines the steps to convert whatever components are available into a 
full MultiMode PicoForce system. The one-step upgrade of a MultiMode SPM from a system 
including a pre-NSIIIa Controller to a full MultiMode PicoForce appears across the top of the flow 
chart, In general, components that may require upgrade appear in decision diamonds, mostly along 
the left of the chart; the individual upgrade solutions appear in boxes, mostly along the right of the 
chart. Each element is discussed below.

• MultiMode PicoForce requires an SPM controller with phase measurement capability. 
There are three possibilities:

 an NSV Controller (which incorporates the Quadrex module),

 an NSIV(a) Controller (which incorporates the Quadrex module),

 an NSIIIa Controller with an Extender Electronics Module, or

 an NSIIIa Controller with a Quadrex module.

Note: Select Quadrex over Extender phase signal handling if your applications 
include quantitative PhaseImaging of cantilever oscillation phase angles with 
respect to the driving frequency.

• MultiMode PicoForce uses an additional analog-to-digital converter (ADC) compared 
to standard MultiMode. The PicoForce Option “ADC5 Upgrade” (see Figure 4.1a) to 
MultiMode systems based on the NSIIIa Controller adds an ADC either via the ADC5 
product (providing three more ADCs in all) or by installation of a single integrated 
circuit. The NSIV Controller includes all features of both the NSIIIa Controller with the 
ADC5 Upgrade, so does not require an additional ADC5 Upgrade.

Note: Refer to Support Note 255, A/D Upgrade for details of the ADC5 Upgrade and 
its installation procedure. Adding the one ADC integrated circuit is also easy. 
Either installation is typically performed by Bruker personnel.
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Figure 4.1a   MultiMode PicoForce System Configuration Flow Chart
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Installation: Upgrade to PicoForce
Installation of Upgraded Components
• The laser light source used for optical lever photodetection (see Figure 1.1c) in 
MultiMode PicoForce systems generates visible red light like the laser used in standard 
MultiMode SPMs. The superior force resolution of MultiMode PicoForce derives from 
specified light emission characteristics of the laser and the geometric arrangement of 
components of the optical lever. Together, these enhancements define the low noise 
MultiMode head used in the PicoForce Option.

• The PicoAngler interface requires an additional serial port for MultiMode PicoForce 
compared to standard MultiMode SPM operation.

• The combination of NanoScope software version 6 or 7, the data rate requirements for 
cantilever deflection signal sampling, PicoAngler interaction and realtime display result 
in the need for a minimum of 1700MHz computer clock speed in a MultiMode 
PicoForce-compatible computer. Bruker recommends a minimum of 512MB of RAM.

• The PicoForce Scanner is optimized for push/pull applications orthogonal to the sample 
plane and includes an embedded Z-axis sensor for closed loop control in that axis. The 
PicoForce Scanner can also be used for imaging.

Note: For the highest resolution imaging applications without the need for pushing or 
pulling, use an alternative scanner to the PicoForce “PF” scanner.

4.2 Installation of Upgraded Components

Contact Bruker (either your local representative or 805 967 1400) for assistance evaluating an 
existing MultiMode SPM system for upgrade to MultiMode PicoForce and/or for coordination of 
the installation. Coordination of the upgrade of components can speed the process of assembling a 
MultiMode PicoForce system from a MultiMode SPM. Upgradable components are listed by 
upgrade procedure in Table 4.2a.

Table 4.2a   MultiMode PicoForce Component Upgrade Processes

Owner Installs (or Bruker Assists): 
External Cabling Only

Owner Installs (or 
Bruker Assists): 

Including Internal 
Modifications

Owner Sends Item; 
Bruker Upgrades & 

Returns It

MultiMode SPM — Low noise head

NSIIIa, NSIV(a) or NSV Controller — —

Extender/Quadrex module (with NSIIIa only) ADC5 Upgrade, including  
jumpers (NSIIIa only)

—

MultiMode PicoForce-compatible computer Additional computer serial 
port

—

PicoForce Scanner — —

PicoAngler — —

PicoForce Control Module — —
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Reference the documentation, including installation procedures, provided with major MultiMode 
PicoForce components:

• MultiMode SPM—MultiMode Scanning Probe Microscope Instruction Manual

Note: Conversion between PicoForce and other scanners is described under Unpack 
the System within Chapter 3, Setup & Installation of the MultiMode 
Scanning Probe Microscope Instruction Manual.

• NanoScope IV(a) Controller—NanoScope IV(a) Controller Manual

• NanoScope V Controller—NanoScope V Controller Manual

Note: There is no corresponding manual for the NanoScope IIIa Controller.

• Extender Electronics Module—Support Note 205, Hardware and Software Installation—
                      Extender Electronics Module:  MultiMode AFM

• Quadrex—Support Note 322, Quadrex PhaseImaging

• ADC5 Upgrade—Support Note 255, ADC5 Installation and Operation

• NanoScope Version 6 Software—NanoScope Software 6.0 User Guide

• NanoScope Version 7 Software—NanoScope Software 7.0 User Guide

Cabling interconnections among MultiMode PicoForce components is the same for new and 
upgraded systems (see Hardware Configuration, page 13).

CAUTION: Make sure you review Important: Powering Sequence, page 17, 
before powering your upgraded MultiMode PicoForce system.
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Chapter 5   Hardware Orientation
The most complete introduction to each component of a MultiMode PicoForce system appears in 
the directly associated documentation. Refer to the manuals listed at the end of Chapter 4 for details 
of MultiMode SPM, the NanoScope IV and V Controllers, the Extender Electronics Module, 
Quadrex and Versions 6 and 7 of NanoScope software. The PicoForce-specific components are 
introduced in this manual:

• the PicoForce scanner (see MultiMode PicoForce Specifications, page 136, for its 
essential characteristics)

The PicoForce scanner scans over up to 40m along both the X and Y axes and incorporates a Z-
axis capacitive sensor for closed loop positioning within 0.5nm RMS over 20µm of travel toward 
and away from the sample stage.

Figure 5.0a   PicoForce Scanner

• the PicoAngler (see PicoAngler Mode, page 68)

The PicoAngler provides the most unconstrained method of applying force to a sample through the 
probe. The PicoAngler is discussed following the presentation of more constrained force 
application techniques: pre-programmed basic and scripted force curves.

• the PicoForce Force Spectroscopy Control Module (see the next section).
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5.1 The PicoForce Control Module Front Panel

The PicoForce Force Spectroscopy Control Module, shown in Figure 5.1a, provides a switch 
between (Pico)ANGLER OUTPUT and USER INPUT, as well as labelled BNC connectors as 
described below.

Note: The PicoForce Control Module front panel BNC connectors are not required 
for MultiMode PicoForce operation. They are included to provide additional 
access to “internal” signals that would otherwise require a Signal Access 
Module to observe.

Figure 5.1a   The PicoForce Control Module Front Panel

When illuminated, the three lights in the upper left of the PicoForce Control Module front panel 
indicate, from left to right,

1. PicoForce Control Module power on,

2. communication established: PicoForce Control Module and NanoScope controller, and

3. the PicoForce scanner is operating under Z-axis closed loop control.
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The signal specifications for the PicoForce Control Module BNC connectors are described below 
and first summarized in Table 5.1a.

Table 5.1a   Connections to PicoForce Control Module Front Panel External Terminals

Description of the individual signals accessible on the PicoForce Control Module front panel:

• DEFLECTION OUTPUT—is the electrical representation of the bending of the cantilever. 
The “vertical” photodetector output signal from top quadrants A (left) and B (right) and 
bottom quadrants C (left) and D (right), combine (Figure 5.1b) in the voltage [(A+B)-
(C+D)]/[A+B+C+D], representing the degree of deflection of the optical lever. The 
deflection signal range is approximately ±10V and is proportional to the cantilever 
bending. Its initial value while the cantilever is off the sample surface is set using the 
vertical deflection adjustment knob on the MultiMode head as described in the 
MultiMode SPM Manual. Deflection values greater than this non-contact value indicate 
that the tip is deflecting upwards (pressing on the surface). Conversely, lesser values 

WARNING: Because the ±220V piezoelectric element drive signals 
are routed from the NanoScope controller through the 
PicoForce Control Module and on to the MultiMode, 
precautions must be observed to contain equipment 
damage and avoid injury in the unlikely event of a 
failure resulting in a high voltage appearing on the 
signal conductor of an external BNC terminal of the 
PicoForce Control Module. Therefore:
          Only make connections to equipment with no 
accessible ungrounded surfaces.
          Only make connections to equipment with signal-
to-ground insulation rated for at least 450V.
Only make connections to equipment designed for the 
intended use and with electrical termination that 
constrains the conveyed signal within the limits set in 
Table 5.1a. For instance, a 10V analog output introduced 
to an oscilloscope through an input impedance of 1k 
limits current to 10mA.

Connector Label
BNC Signal 

Type Voltage Range Current Limit

DEFLECTION OUTPUT Analog output ±10V 10mA

SENSOR OUTPUT Analog output ±10V 10mA

MODIFIED LV OUTPUT Analog output ±12V 10mA

TRIGGER INPUT TTL input 0-5V n/a

MANUAL OFFSET OUTPUT Analog output ±10V 10mA

MANUAL OFFSET INPUT Analog input, 
1M¾ impedance

±10V 10mA
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indicate that the tip is bending down (pulling on the sample). See Realtime Analysis, 
page 77 for more information on how this voltage signal can be converted to units of 
distance and force.

Figure 5.1b   Optical Lever Monitoring by Segmented Photodetection

• SENSOR OUTPUT—is the closed loop sensor signal which is proportional to the Z-
position of the PicoForce scanner. The sensor generates the closed loop feedback signal, 
so is the essential monitoring component of the Z-axis control loop. The sensor output 
signal ranges over ±10V and is linearly proportional to the Z-position of the scanner, 
where 10V indicates that the scanner is fully extended (the tip-sample distance is 
minimized) and -10V indicates the scanner is fully retracted (the tip-sample distance is 
maximized).

Note: During calibration before shipment, Z SENSOR SENSITIVITY is set to -1000nm/
V. The parameter should not be changed from this value.

• MODIFIED LV (Low Voltage) OUTPUT—is the Z-axis position drive signal. The “low 
voltage” (LV) signal, which is amplified to become the “high voltage” (HV) signal that 
drives the scanner piezoelectric Z-actuator, may be modified from either of two external 
sources, the PicoAngler or an external input, but not both simultaneously. (This signal is 
also modified internally as part of engaging and withdrawing the tip with respect to the 
sample.) When the Control Module switch is set to ANGLER OUTPUT, adjustment of the 
Z-position knob on the PicoAngler modifies the LV signal. When the Control Module 
switch is set to USER INPUT, the signal input to the MANUAL OFFSET INPUT BNC is 
similarly added to the LV signal. See External Input Mode, page 73, to use this input.

• TRIGGER INPUT—can be used to synchronize a force measurement with an external 
signal. A pulse applied to the TRIGGER INPUT BNC initiates a force measurement 
through the software. See External Input Mode, page 73 for more information on this 
function.
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• MANUAL OFFSET OUTPUT—the signal produced by adjusting the PicoAngler knob and 
which is added to the internal LV Z-axis signal when the Control Module switch is set to 
ANGLER OUTPUT.

• MANUAL OFFSET INPUT—available, when the Control Module switch is set to USER 
INPUT, for external input of a signal to add to the internal LV signal in the same way 
PicoAngler adjustments do.

• ANGLER OUTPUT—the Control Module switch position for PicoAngler control of the 
sample platform position.

• USER INPUT—the Control Module switch position for externally supplying a signal to  
control the sample platform position.
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5.2 The PicoForce Control Module Back Panel

The PicoForce Force Spectroscopy Control Module back panel is shown in Figure 5.2a. Input AC 
power requirements and fuse ratings are specified in tables along the bottom, left of center, of the 
back panel and reproduced in Troubleshooting: General, page 117.

Figure 5.2a   The PicoForce Control Module Back Panel

Note: The POWER on/off switch is integral to the power cord connector at the left of 
the back panel.

Note: The Advanced Acquisition Port (center of back panel) is used for the High 
Sampling Rate Option (see Advanced Data Acquisition Port Pin 
Identification, page 30).

The four multi-conductor connectors at the right of the back panel link the PicoForce Control 
Module to the computer, the PicoForce scanner, the NanoScope controller and the MultiMode 
SPM. The system connections and distinguishing characteristics of the different cables are detailed 
in Hardware Configuration, page 13.

5.3 Using the Advanced Acquisition Port

Note: NanoScope III, IIIA and IV controllers acquire data at a maximum rate of 
60kHz. For most MultiMode PicoForce applications that is sufficient and this 
section can be skipped.

If you need a higher sampling rate, the MultiMode PicoForce Advanced Data Acquisition Port (see 
Figure 5.2a) is provided for convenient optional interfacing with the National Instruments® (NI) 
brand of data acquisition (DAQ) boards. This option is useful if you desire faster data capture rates 
or a custom software interface. The interface has been tested by Bruker with the NI 6052E DAQ 
board, which is a 16-bit eight input (differential mode), 2 output, 333kHz sampling model. 
However, many of the NI DAQ boards share the same interface connector pinout but with varying 
speeds, numbers of inputs/outputs and other features. Please contact National Instruments for 
details on their DAQ card capabilities and application information.

CAUTION: MultiMode PicoForce supports three alternative power supply 
voltages. Verify that the selected option is visible where the power 
cord attaches and that the fuses installed are consistent with the 
voltage available: either 100, 120 or 240VAC
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Note: Bruker does not sell, warrant, or support any NI product. As such, Bruker 
cannot provide hardware, software, or technical support for this feature beyond 
our own circuitry which provides and accepts signals to/from the NI DAQ 
board. Although Bruker has made every effort to protect the interface against 
short circuits and other electrical faults, the user must accept all responsibility 
for damage to Bruker or other equipment resulting from misuse of this 
interface.

Alternatively, the NanoScope V Controller provides much higher sampling rates.

5.3.1 Connector Pinout

The Advanced Data Acquisition Port is a standard 68 pin connector used on many NI DAQ 
products. Please consult NI on the availability of cables to connect your NI DAQ board to the 
Advanced Data Acquisition Port.

Signals are configured as follows:

Inputs to a National Instruments DAQ Card

The inputs should be configured as differential inputs on the NI card, which means that each input 
has an independent ground reference.

Table 5.3a   Advanced Data Acquisition Port Pins Used to Input to NI DAQ Cards

Note:  The filtered deflection signal is filtered by an 8th order Butterworth response 
switched capacitor lowpass filter. The corner frequency of this filter is 
programed by a clock on Pin 1 of the NI connector (FREQ_OUT). The clock 
frequency to corner frequency is set at a ratio of 50:1 (i.e.- 5MHz clock results 

Pin # NI Signal PicoForce Signal

68 ACH0 Raw Deflection

34 ACH8 Raw Deflection ground reference

33 ACH1 Filtered Deflection (see note below)

66 ACH9 Filtered Deflection ground reference

65 ACH2 Knob/User Offset

31 ACH10 Knob/User Offset ground reference

60 ACH5 Modified low voltage Z (LVZ)

26 ACH13 Modified LVZ ground reference

57 ACH7  Z Sensor

23 ACH15 Sensor ground reference
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in 100kHz lowpass filter, 2MHz clock results in 40kHz low pass filter). 
Allowable clock frequencies are 1-5MHz, which gives a tunable filter range of 
20-100kHz. The output of this filter is not valid if no clock is present.

Outputs from a National Instruments DAQ Card

Table 5.3b   Advanced Data Acquisition Port Pins Used to Output from NI DAQ Cards

The Advanced Data Acquisition Port pin assignments appear in Figure 5.3a.

Figure 5.3a   Advanced Data Acquisition Port Pin Identification

Pin # NI Signal PicoForce Signal

22 DAC0OUT Adds NI offset to the existing Modified LVZ
(Modified LVZ= LVZ (from NS controller)
                        + Knob/User Offset + NI offset)

55 AOGND NI offset ground reference

Pins Protruding in Connector on Back Panel of PicoForce Control Module

       34  33 32  31  30 29  28 27  26 25  24  23 22  21  20 19 18  17 16  15 14  13  12  11 10   9   8    7   6    5    4   3    2   1

68  67 66  65 64  63 62  61 60  59 58  57 56  55  54  53 52  51 50  49 48  47 46  45  44  43 42  41 40  39 38  37 36  35 

8277
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Chapter 6   Software Orientation
PicoForce is among the first Bruker products available exclusively in Version 6 of NanoScope 
software. Version 6 features a new look and a re-organization of SPM control parameters and 
options. Version 7 is an evolution of Version 6 and is required to support the NanoScope V 
Controller.

Note: For a more detailed introduction to the Version 6 or 7 NanoScope software 
environment, refer to the NanoScope Software 6 User Guide or the NanoScope 
Software 7 User Guide.

6.1 Network Connection

MultiMode PicoForce is shipped with a network port in the computer, but not enabled. This avoids 
a warning message if you wish to first run the system without connecting to a network. To enable 
the network card, perform the following before starting NanoScope software:

1. Click desktop icon MY COMPUTER to open the My Computer panel (see Figure 6.1a).

2. Click the CONTROL PANEL icon to open the Control Panel.

3. Click the SYSTEM icon to open the System Properties panel.

4. Select the Hardware Profiles tab. Click PROPERTIES to open the Original Configuration 
Properties panel.

5. Select the Network tab in the Original Configuration Properties panel.

6. Remove the check from NETWORK-DISABLED HARDWARE PROFILES box.

7. Close (click the X in the upper right corner of the panel) the Original Configuration 
Properties panel, the System Properties panel, the Control Panel, then the My Computer 
panel.

Note: Bruker does not supply network services (such as Internet access). Consult a 
local provider to make use of the computer communications capabilities now 
enabled in your MultiMode PicoForce system.
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Figure 6.1a   Enabling the Computer Network Card

6.2 PicoForce Software Configuration

Double-click the desktop NanoScope icon, shown in Figure 6.2a, to run NanoScope software.

Figure 6.2a   NanoScope Icons, version 6 (left), version 7 (right)

Initially, the software is configured for MultiMode PicoForce and the following section can be 
skipped. To verify or change your system configuration:

1. Click Tools > SELECT MICROSCOPE to open the Microscope Select panel (see Figure 6.2b).

2. Click the EDIT button in the Microscope Select panel (see Figure 6.2b) to open the 
Equipment panel (see Figure 6.2c).

3. Verify or enter a distinguishing name for your SPM system under DESCRIPTION. The name 
entered will be added to the MICROSCOPE SELECT list when the Equipment panel is closed.
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4. Select V (for NSV), IV (for NSIV) or IIIA (for NSIIIa) for CONTROLLER in the 
Equipment panel.

Figure 6.2b   The Microscope Select Panel

5. Select PICOFORCE for MICROSCOPE in the Equipment panel (see Figure 6.2c). Select BASIC 
or QUADREX (if installed) for the EXTENDER of your NSIIIA system. (EXTENDER is not an 
option if the NSIV or NSV CONTROLLER is selected.)

Figure 6.2c   System Component Designation 

6. Select NONE for SENSOR for PicoForce operation. The remaining parameter assignments 
shown in Figure 6.2c are representative; appropriate values appear initially and do not need 
adjustment.
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Note: The PicoForce Control Module-to-computer serial communication cable (see 
Figure 3.2f, page 15, cable “D”) is assigned to computer port COM1 in this 
Manual. If you choose an alternative port, be consistent in hardware and 
software configurations.

7. Click the SERIAL... button of the Equipment panel to open the Serial Port Configuration 
panel (see Figure 6.2d). Select COM 1 then press the EDIT button to open the Edit Port 
Setup panel (see Figure 6.2e). Verify or select PICOFORCE from the drop-down menu for 
COM 1 EQUIPMENT TYPE. The other parameters in the panel should be set as they appear in 
Figure 6.2e. Click OK to close the Edit Port Setup panel. Click DONE to close the Serial 
Port Configuration panel. Click OK to close the Equipment panel. Click OK to close the 
Microscope Select panel.

Figure 6.2d   Serial Port Configuration Panel
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Figure 6.2e   The Edit Port Setup Panel

6.3 NanoScope Software Versions 6 and 7

Refer to the NanoScope Software Version 6 or Version 7 User Guides for use information regarding 
NanoScope software.
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Chapter 7   Pulling: Theory and Principles
7.1 Context: Conventional Force Plots

Conventional force plots are simply a plot of cantilever deflection on the Y-axis versus Z-piezo 
position on the X-axis. They normally include two traces, an approach curve and a retract curve. On 
a hard surface in air, a curve similar to that shown in Figure 7.1a is commonly obtained. The tip-
sample distance decreases as the curve goes from right to left (arrow one). Very close to the surface, 
the tip snaps into contact with the surface due to short range attractive forces (arrow two). As the 
piezo continues to extend, the tip is pressed harder into the surface and the cantilever deflection 
increases. The piezo then reverses direction and begins to increase the tip-sample distance, thus 
decreasing the cantilever deflection. However, instead of immediately returning to its non-contact 
value, the deflection commonly continues to decrease. This indicates that the tip is “stuck” to the 
surface in the thin layer of water and other debris. As the piezo continues to retract, the cantilever 
strains against this force until it finally breaks free and returns to its non-contact value (arrow 4). 
Force plots obtained during single-molecule force spectroscopy experiments are similar except that 
they are conducted in fluid, which greatly reduces the snap-into-contact distance (arrow 2), and the 
attractive force of the retract portion is due to a molecule being stretched between the tip and the 
sample surface.

Figure 7.1a   A Traditional Force Plot

More generally, a force plot can be any graph of cantilever response (i.e.- deflection, TappingMode 
Amplitude, TappingMode Deflection, etc.) vs. some value indicative of the Z-axis position 
(calculated Z position, Z sensor value, tip-sample separation, etc.). These other options will be 
considered in more detail in other sections.
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7.2 Sensitivity Enhancements for Force Measurement

Turning a MultiMode into a MultiMode PicoForce capable of resolving piconewton forces requires 
enhanced force plot data collection and interpretation techniques. The three primary issues are: 
measuring the cantilever deflection, plotting the forces against an accurate position axis, and 
converting the deflection to units of force.

The most important factor in improving force measurement performance is to ensure that the 
instrument is thermally-limited. This phrase refers to the thermal motion, or “noise,” of the 
cantilever itself. Any cantilever will vibrate at its resonant frequency due to thermal energy alone. 
Any measurement of cantilever deflection will have this noise superimposed on the rest of the data, 
provided that the measurement bandwidth includes the resonant frequency. The magnitude of this 
noise varies with the spring constant of the cantilever and with temperature, but typically is less 
than 0.5nm for most typical cantilevers. A common, and at first intuitively appealing, 
misconception for those new to the field is that you should always be able to measure smaller 
forces by simply using a softer cantilever, the idea being that a given force will produce a larger 
deflection on the softer cantilever, thus being easier to measure. The problem with this idea is that 
thermal noise increases with decreasing spring constant. Thus one rapidly approaches a point of 
diminishing returns when using extremely soft cantilevers. There have been experimental attempts 
with some success at either actively damping this noise or moving the thermal noise to a frequency 
higher than the measurement bandwidth so that softer cantilevers can be used. However, just 
achieving thermally-limited operation is sufficient for most force measurements.

To reach thermally-limited operation, the instrument must not add noise to the deflection 
measurement or to the actual cantilever oscillations. Therefore the MultiMode PicoForce uses a 
low noise AFM head that greatly reduces laser interference effects that can occur using a standard 
MultiMode AFM head. The standard MultiMode AFM head contains a red laser diode for 
measuring the cantilever deflection with the optical lever technique. This standard head was 
developed for normal imaging modes in which the cantilever-surface separation is typically very 
small and does not change very much. Because of these conditions laser interference is rarely a 
problem when using the standard AFM head for imaging. However, during the measurement of a 
force plot, the cantilever-sample separation changes from almost zero to up to several microns. 
These conditions make the optical lever path much more subject to laser interference. This leads to 
periodic noise on the force plots, which can interfere with force measurements on the piconewton 
scale. The low-noise head incorporates a low-coherence length laser diode. The result is an optical 
lever path that is free of laser interference noise.

Note: Spurious laser interference is periodic with amplitude maxima (or minima) at 
one half of the coherent light wavelength. To spread apart these occurrences of 
concentrated noise in the light signal, a longer wavelength laser is an option. To 
substitute an infrared (IR) laser for the low-noise MultiMode PicoForce red 
laser, contact Bruker. However, because infrared light is invisible to the 
unaided eye, laser alignment is more complicated and greater care must be 
taken to avoid eye damage with an IR laser.

In addition to eliminating detection noise, the MultiMode PicoForce avoids having noise coupled 
into the cantilever oscillations. Additional oscillations can result if, for instance, the sample 
position is vibrating and these motions couple to the cantilever through the intervening fluid. The 
MultiMode PicoForce uses a low-noise capacitive sensor integrated into a carefully designed and 
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tuned feedback loop to control the sample Z-axis position. This design results in a system with low 
noise in both sample position and cantilever deflection.

The closed-loop Z-axis also accomplishes the second goal of plotting the forces against an accurate 
position axis. Most SPMs, including the standard MultiMode, plot forces versus a calculated Z- 
position based on the anticipated response of the Z-piezo to a given voltage. However, undesirable 
piezo properties such as creep, hysteresis, and nonlinearity can make this position axis inaccurate, 
especially for irregular, non-cyclic force plots. The low-noise Z-axis sensor and closed loop Z-axis 
control ensure that the Z-position is both known and at the exact position specified by software.

The final issue, converting the deflection to units of force, is somewhat more complicated. It 
requires calibrating the spring constant of the force-measuring cantilever so that one can convert 
nanometers of deflection to piconewtons of force. This calibration is discussed at length in Spring 
Constant Calibration, next. The PicoForce package includes the ability to calibrate the spring 
constant with the thermal noise method. However, alternative strategies are included below so you 
can appreciate the complexity of the issue and perhaps try other techniques on your own.

7.3 Spring Constant Calibration

While the MultiMode cantilever moves in response to forces on it, the measurement made by 
optical lever—bouncing a laser off the top of the cantilever and into a photodetector—is of the 
cantilever free end position as a function of time. When cantilever deflection is sufficiently small, 
as is the case in most Contact Mode and TappingMode applications, the relation of the force on the 
tip to the cantilever free end position is elastic, that is, linear, given by Hooke’s Law applied to a 
spring:

F = -k  h

where F = the force on the tip in newtons,
           h = vertical displacement of the free end of the cantilever toward or away from the sample
                 in meters, and
           k = the proportionality constant, known as the spring constant, in newtons/meter (or
                  equivalently, and more typically in nanoscale work, in piconewtons/picometer).

Given the spring constant of a cantilever, measured cantilever deflections are converted into 
inferred tip/sample forces. Therefore, the first step in making accurate force measurements is the 
determination of the spring constant of the cantilever to be used.

Note: The spring constant is a property of the cantilever. For instance, if determined 
in air, the spring constant applies to the same cantilever in water or vacuum. 

Four methods to deduce a cantilever spring constant are described. Arguably trading off some 
accuracy for negligible time and effort, MultiMode PicoForce automates the thermal tune method.

1. estimation from representative geometry,

2. comparison with and without added mass,

3. thermal tuning, and

4. by hydrodynamic model.
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A complete discussion of this topic can be found in Bruker Application Note 94, “Practical Advice 
on the Determination of Cantilever Spring Constatnts,” available at http://bruker.com/library. 
Additional information may be found in “Cantilever spring constant calibration using laser Doppler 
vibrometry,” Benjamin Ohler, Rev. Sci. Instrum., 78, 063701 (2007).

7.3.1 Estimation from Cantilever Geometry

This first method is quick, but suffers from uncertainty because typically the specific cantilever 
geometry is not measured and may vary in production. Instead, a representative of the appropriate 
family of cantilevers is used. Each cantilever family is distinguished by a tip factor, b in newton-

seconds3/meter, and the spring constant for a cantilever in the family is derived from the measured 

resonant frequency, f in seconds-1, of the free cantilever in air by:

k = b  f3

The assumptions that go into this relation are that cantilevers within a family agree in material 
properties and in geometry, with the exception of cantilever thickness, which varies within the 
family. Typical average tip factor values by cantilever class are provided in Table 7.3a.

Table 7.3a   Typical Tip Factor Values

Identify your probe cantilever type, measure its resonant frequency (click the CANTILEVER TUNE 
icon (shown)), and calculate its spring constant using the above formula. See the Bruker website, 
www.bruker.com, for more information about available probes.

Note: For an explicit expression for the spring constant of a single beam cantilever 
with rectangular cross section in terms of its geometry (other than cantilever 
thickness), material properties and resonant frequency (cubed, as noted above) 
see the end of Adding Mass to the Cantilever, next.

Cantilever Class
Representative Cantilever 

Families
Tip Factor

V-shaped, Contact Mode NP, DNP, OTR, ORC 7newton-seconds3/meter

Single beam, TappingMode ESP, FESP, LTESPW, MESP, 
RTESPA, TESP, FIBLADE, 
FISPIKE, IBMSC

4

Single beam, indentation DNISP 2
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7.3.2 Adding Mass to the Cantilever

The second method of spring constant determination contrasts with the first in requiring careful 
work that is rewarded with a more accurate value. Measure the resonant frequency before and after 
adding a known mass to the cantilever and the resonant frequency shift specifies the cantilever 
spring constant.

The method is derived here for a model appropriate to TappingMode probes, a single beam 
cantilever of rectangular cross-section, whose spring constant is given by.

where E = the elastic modulus (Young’s Modulus),
            t = the cantilever thickness
           w = the cantilever width,
            L = the cantilever length.

The resonant frequency of such a beam is:

where m* = the effective mass (Ý 0.24m, for beam mass, m = twL, the cantilever density),
            M = the known mass added to the cantilever free end.

Re-arranging the last equation, added mass, M, varies linearly with (2¼f)-2: M = k(2¼f)-2 - m*. As 
a linear relation, comparing the resonant frequency with one added mass to that without any is 
sufficient to solve for both the spring constant and the effective mass of the cantilever:

The first solution of the simultaneous equations provides the spring constant, given the added mass 
and the two resonant frequencies, with added mass, f1 and without, f0. The accuracy of the spring 

constant determination depends primarily on the uncertainty in the added mass as the resonant 
frequencies typically may be measured to higher precision.

Various methods have been used to affix particles to cantilevers. Three such procedures, developed 
by  researchers using Bruker NanoScopes, are detailed in Support Note 226B, Attaching Particles 
to AFM Cantilevers. By using a cantilever before calibrating it, one can avoid the step of removing 
the added mass to perform an experiment with a calibrated cantilever.

Substituting the first equation of this section, the expression for spring constant in terms of 
cantilever geometry and material properties, k(E, t, w, L), into the second equation of this section, 
the expression for cantilever resonant frequency in terms of spring constant and mass components, 

f(k, M, m*), the latter equation, f(E, t, w, L, M, m*), now reflects geometric characteristics. Re-
arranging the new equation as an expression of cantilever thickness in terms of the other variables, 

k
Et3w
4L3

-------------=

f

2
------ 1

2
------ k

M m+
-------------------= =

k 2 2 M
1 f1

2  1 f0
2 –

---------------------------------------= m M
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2 f1

2–
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now including resonant frequency, that is, as t(E, w, L, M, m*, f), the re-arranged equation is 
substituted for thickness back in the first equation to demonstrate that spring constant is 
proportional to resonant frequency cubed, independently of cantilever thickness:

For further discussion of this derivation, refer to A Nondestructive Method for Determining the 
Spring Constant of Cantilevers for Scanning Force Microscopy, by J. P. Cleveland, et. al., in 
Review of Scientific Instruments, 64 (2), February 1993, page 403.

7.3.3 Measuring Thermal Noise

The third method of spring constant calibration is often preferred because it is neither as 
demanding and time-consuming as attaching a particle (method two) nor has as large an associated 
uncertainty as relying on a representative model (method one). The measurement data consists of a 
time interval of the deflection signal in Contact Mode (i.e., with no driving oscillation applied 
electronically) at thermal equilibrium, while the cantilever is suspended, away from any solid 
surface. Brownian motion of surrounding molecules (e.g., air) impart random impulses to the 
cantilever during the sampling. The resulting function of time is Fourier transformed to obtain its 
Power Spectral Density (PSD) in the frequency domain. Integrating the area under the resonant 
peak in the spectrum yields the power associated with the resonance.

Expressing the dynamics of the cantilever as a harmonic oscillator by the total system energy (the 
Hamiltonian), the average value of the kinetic and potential energy terms are both

according to the Equipartition Theorem, where T is the temperature in kelvins and kB is 

Boltzmann’s constant = 1.380510-23joules/kelvin. In particular, for the potential energy, 

where 0 = Ð(k/m) is the resonant angular frequency, m is the effective mass, z is the displacement 

of the free end of the cantilever and the “angle” brackets indicate average value over time. 
Simplifying, the temperature and average displacement determine the cantilever spring constant.

The original displacement time-series is Fourier transformed to segregate other, broadband, noise 
contributions from the narrowband thermal noise around resonance. By integrating the area under 
the resonance in the PSD, while excluding both the noise floor and the “shoulders” to either side of 
the resonance peak, only the power, P, of the thermal cantilever fluctuations is included. The latter 
is equal to the mean square of the time-series data. For further discussion of this derivation, refer to 
Calibration of Atomic-Force Microscope Tips, by Jeffrey L. Hutter and John Bechhoefer, in 
Review of Scientific Instruments, 64(7), July 1993, page 1868.

k 23L3wf0
3 3 E=

1
2
---kBT

1
2
---m0

2z2  1
2
---kBT=

k kBT  z2  kBT  P= =
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The MultiMode PicoForce automates the thermal tune calculations. Ten seconds of sampling is 
sufficient to define the PSD with 25Hz frequency resolution.

The accuracy of the thermal method of cantilever spring constant determination depends not only 
on the effective isolation of nonthermal noise contributions to the PSD, but also on the accuracy of 
the PSD and on its magnitude. The Nyquist Sampling Theorem guarantees Fourier Transform 
accuracy for frequencies up to one half the sampling rate. The standard NanoScope III or IV 
controller samples the deflection signal every 16.5s, corresponding to a 64kHz sampling rate. 
Therefore, cantilever resonances with contributions from frequencies above 32kHz can produce 
distorted PSDs. This particularly constrains using the method for small cantilevers in air. For this 
reason a High Sampling Rate Option is available for MultiMode PicoForce systems (see Using the 
Advanced Acquisition Port, page 28). Most biologically interesting samples are best preserved in 
a fluid environment where cantilever resonant frequencies are considerably lower than in air.

Because the magnitude of the PSD is proportional to the average cantilever displacement, higher 
spring constant (stiffer) cantilevers produce a smaller signal to analyze. For instance, a spring 
constant of 0.05N/m produces cantilever displacements of approximately 0.3nm at room 
temperature. This is representative of the probes with the smallest spring constants in Table 7.3a: 
SiN, NP, NP-STT, DNP, DNP-S (0.01-0.6N/m), and OTR4 (0.02-0.08N/m) among V-shaped 
cantilevers, and ESP (0.02-0.1N/m) among single-beam cantilevers.

7.3.4 Rectangular Cantilever, Hydrodynamic Model

By comparing resonance in vacuum to in fluid for a rectangular cantilever and introducing the 
hydrodynamic function, which depends on the fluid Reynolds number, cantilever spring 
constant is computed from easily obtained resonance characteristics and the less variable of probe 
dimensions:

where w and L are defined as before (see page 41), f = density of the fluid (e.g., 1.18kg/m3 for air),

           Qf = the cantilever resonance quality factor in fluid,

           f = cantilever resonant frequency in the fluid,

           i, the imaginary component of the hydrodynamic function, , where

k 0.1906fw
2LQfi f( )f

2=

 ( )  ( ) 1
4iK1 i–  iRe( )

iReK0 i–  iRe( )
-----------------------------------------------+=
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and rii, where,

and

where = log10(Re), and the Reynolds number, Re = fw2/(4) for fluid viscosity KandK
are modified Bessel functions of the third degree (refer to a source for mathematical functions).

The simplicity of data acquisition and computation (once the equations are set up!) are balanced by 
a few limitations to the method:

• the leading numerical term (0.1906) assumes a high aspect ratio rectangular cantilever 
with L/w > 5

• Qf >> 1; a high quality resonance is required: air is a suitable fluid, water is not.

For a derivation of this method, refer to Calibration of Rectangular Atomic Force Microscope 
Cantilevers, John E. Sader, James W. M. Chon and Paul Mulvaney, Review of Scientific 
Instruments, Vol. 70 (10), October 1999.

7.4 Single Molecule Force Spectroscopy

One key application for which the MultiMode PicoForce is intended is single molecule force 
spectroscopy. This field encompasses a variety of applications, but can be broadly grouped into two 
categories: intra-molecular forces (the forces that maintain the folded domain structure of proteins) 
and inter-molecular forces (the binding force between an antibody and its antigen or between cell 
receptor molecules and their targets). Although somewhat different in their experimental setup, 
both categories require piconewton precision because they involve forces on the single molecule 
scale.

A typical intermolecular binding experiment involves binding one of the molecules to the tip and 
the corresponding molecules with which it interacts to the substrate surface (see Tip and Sample 
Preparation, page 47). The tip is then brought to the substrate surface before being retracted. If a 
binding event occurs during the brief period at the surface, a negative deflection results on the 
retract portion of the force plot. Care must be taken in interpreting the magnitude of the force since 
it is quite likely for there to be multiple molecular pairs interacting. Commonly the experiment is 
repeated many times and the unbinding force plotted in a histogram. Often a pattern will emerge 
where the unbinding force is always some integer multiple of some smaller force, which is 
presumably the magnitude of a single binding event.

Single molecule pulling experiments on intra-molecular forces are conducted quite similarly. 
However, in these cases the tip is used without modification and the molecule of interest is simply 
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allowed to bind to a flat substrate such as mica or gold-coated glass. As before, the tip is brought 
down to the surface. Commonly it is allowed to sit on the surface with a force of ~1nN for a second 
or so before being retracted. If a molecule binds to the tip in that time, a negative deflection pattern 
will appear on the retract portion. Sometimes no binding occurs and sometimes several molecules 
are stretched at once. But often a single, reproducible “fingerprint” emerges such as that shown 
below in Figure 7.4a. Here, each one of the spikes in the retract portion represents the unfolding of 
a single domain in the protein.

Figure 7.4a   Force Exerted Unfolding a Titin Molecule
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Chapter 8   Pulling: Operation
8.1 Pulling Modes

MultiMode PicoForce features four force measurement modes, one of which has its own dedicated 
controls and data display, while the other three share a common data display interface better suited to 
the modes in which they are obtained.

• Basic Force Mode—Standard approach/retract force plots (see Basic Force Mode, page 50)

• Scripted Force Mode—More flexible interface allowing numerous user-defined segments to 
the force curve (see Scripting Mode, page 61)

• PicoAngler Mode—Realtime, manual control of force measurement with the PicoAngler 
force-feedback knob (see PicoAngler Mode, page 68)

• Manual External Input Mode—Control of tip-sample separation with an external voltage 
signal (see External Input Mode, page 73)

Tip and sample preparation issues are the same for all force measurement modes.

Note: To display cantilever deflection data as force in piconewtons, a value must have 
been entered for DEFLECTION SENS (see Realtime Analysis, page 77) and a value 
must have been entered for Force Tab > SPRING CONSTANT either manually, or by 
activating thermal tune.

8.2 Tip and Sample Preparation

The MultiMode PicoForce takes little time to be ready for measurements once the system is set up. 
Whereas some samples, such as many polymers, require negligible preparation to be pulled, many 
interesting specimens must be prepared and stored appropriately until placed on the SPM sample stage. 
The tip also may be pre-conditioned for certain types of experiments.

8.2.1 Biological Samples

In general, biological samples must be prepared and measured in conditions closely approximating their 
native environment in order for the results to be meaningful. This generally means conducting the 
experiment in a fluid buffer of specified ionic composition and pH and, sometimes, temperature. Refer 
to Support Note 331, Biological Sample Preparation for more information on typical preparation 
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techniques for cells, proteins, and DNA. The TappingMode fluid cell probe holder (model 
MTFML), Figure 8.2a, is used for fluid samples.

For single molecule force spectroscopy experiments, the molecule of interest is typically adsorbed 
on a hard, flat substrate such as mica or gold-coated glass. Many proteins will adsorb to gold due to 
the sulfur-containing cysteine groups that they contain. The gold surfaces are commonly gold 
sputtered, or evaporated onto glass or a polished silicon wafer.

Figure 8.2a    MutiMode (TappingMode, Force Modulation) AFM Fluid Cell

8.2.2 Functionalizing the Tip

In certain force spectroscopy and imaging techniques it is desirable to attach molecules to the 
surface of the tip, generally with the intent that these molecules preferentially interact with other 
molecules on the sample substrate. This sort of tip modification is commonly referred to as 
functionalizing the tip. There have been several methods reported in the literature for attachment, 
including physical adsorption of proteins and covalent attachment via silane or gold-thiol 
chemistry.

Note that it is generally not important to attempt to confine the functionalization to the tip itself. In 
practice, the entire cantilever chip substrate is treated at once. When the measurements are actually 
made, the cantilever and substrate chip are very far from the surface on the scale of the tip and the 
interaction, so whether they are coated is irrelevant.

Depending on the exact functionalization used, the tip may or may not be able to be reused. Tips 
with a very delicate attachment or very low surface concentration of molecules may be rendered 
inactive after a single force measurement. Other tips are more robust and can be used to measure 
many binding events. If you experience a rapid loss of activity, try making your force measurement 
first, taking care to only touch the surface once. For this first measurement, use REALTIME > STEP 
MOTOR... to lower the tip (using TIP DOWN) and take a force curve, successively lowering the tip 
by the SPM STEP SIZE which is set in the STEP MOTOR... panel.
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8.3 Starting a PicoForce Session

The following procedure initiates a PicoForce session, once the sample and probe are in place:

1. Double click the Version 6 NanoScope icon, shown in Figure 8.3a, to start the SPM software.

Figure 8.3a   NanoScope Icons, version 6 (left), version 7 (right)

2. Click the REALTIME icon (a microscope, shown) or click REALTIME > START REALTIME to 
open a new workspace. The Scan View opens with the workspace.

Note: To reduce setup time, restore and reuse a previously defined workspace (see 
your NanoScope Software User Guide).

Note: MultiMode PicoForce ships with a PicoForce workspace to get you started with 
some common settings.

3. Confirm that the software is properly configured for PicoForce (see PicoForce Software 
Configuration, page 32).

4. Engage normally on the surface in Contact Mode (refer to your MultiMode Scanning Probe 
Microscope Instruction Manual and the Command Reference Manual for details).

5. Select a Channel 1 DATA TYPE from the following options:

a. HEIGHT—traditional Contact Mode image signal: height signal generated from voltage 
sent to Z-piezo in response to the deflection setpoint feedback.

b. DEFLECTION—the deflection setpoint feedback loop error signal is near zero when the 
feedback is well-tuned, so this data type is most useful to verify that the gains are well-
tuned, and for observing very small height features.

Note: FRICTION, or lateral deflection, is another option in Force Mode. There are 
other options in other modes.

6. Select a Channel 2 DATA TYPE from the following options:

a. Z SENSOR—the Z-position of the sample platform, the sensor represents the actual Z-
position.

b. Low Voltage Z—the height signal sent to the Z-piezoelectric actuator (before 
amplification), which should correspond well with the height signal in closed loop, but 
not be quite as accurate as the Z sensor in defining probe position vertically.
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Note: This data channel can be configured with a jumper inside the PicoForce 
Controller. Recent PicoForce Controllers (~2006 — present) are configured to 
pass through the “In1D” data line, which disconnects this signal. This is 
necessary to support some modes including STM and TRmode. The Z Sensor 
data type than Modified LV Z. You may consult Bruker for details about 
changing this configuration.

Note: Channel 3 and its plot are constructed from Channel 1 and Channel 2 signals. 
Channel 3 in Force Mode displays a force plot, with some representation of 
cantilever response on the vertical axis and a representation of tip and/or 
sample Z-displacement on the horizontal axis. To display a force plot where Z-
displacement is represented by the tip/sample separation, see Plotting 
Deflection versus Tip/Sample Separation, page 58.

7. Click ACQUIRE > PICOFORCE or, from the workspace view, right click the Real Time icon 
and select PICOFORCE.

8. Select PICOFORCE from the list of view options.

Note: Spring constant calibration by the thermal tune method is a natural first step 
once in Force Mode; see Determine Cantilever Spring Constant by Thermal 
Tune, page 77.

9. If desired, select Workspace > SAVE AS, giving your workspace a name to save it.

8.4 Basic Force Mode

MultiMode PicoForce displays two constituent curves along with their resultant force plot. 
Cantilever response (deflection in Contact Mode, amplitude in TappingMode) and sample
Z-position are each shown as a function of time (DATA TYPEs DEFLECTION and Z SENSOR, 
respectively) as well as combined as a force versus Z-position plot (see Figure 8.4a).

The Force Mode Tab includes seven buttons (whose functions are discussed in greater detail in the 
Command Reference Manual Software Version 5.12 Revision B and the NanoScope Software 
Version 6 or 7 User Guide):

SINGLE

          Perform one force plot extend/retract cycle.

CONTINUOUS

          Begin performing force plot extend/retract cycles in succession.

STOP

          Quit performing force plot extend/retract cycles after completing the current one.

CAPTURE

          Turn on the recording system for saving a force plot.

WITHDRAW

          Immediately disengage the tip from the sample.
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ZERO SETPOINT

           Sets the deflection setpoint equal to the non-contact deflection value in order to correctly 
represent the force with the force feedback feature of the PicoAngler.

DEFL(ection). SENS(itivity).
          Define the conversion factor from cantilever deflection signal voltage to nanometers of 
cantilever displacement (in nm/V) using data in the contact region of a force plot.

Note: The PicoAngler, which may be used for fully manual force plot generation, is 
also useful with basic force plot generation, which is otherwise automated (see 
Using the PicoAngler in Conjunction with Basic Force Plots, page 72).

Figure 8.4a   Force Mode: Channels Tab Featuring Inverted Channel 2 Z-Axis

• The bottom plot in Figure 8.4a shows a force plot in its traditional orientation: with 
cantilever deflection away from the sample increasing upwards on the graph and tip/
sample Z-separation increasing to the right. This results from setting Channel 2 > PLOT 
INVERT to INVERT. Channel 1 (the vertical axis of the plot) may be inverted as well and 
in the same manner.
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• The Z-Center indicator in the upper middle of the Force Mode panel, between the words 
“Retracted” and “Extended,” includes a reading of the voltage applied to the Z-piezo. 
However, any contribution to this voltage from the PicoAngler is not included in this 
number. The Z-Center indicator, useful for assessing tip/sample separation in many 
SPM applications, should be ignored when the PicoAngler is active.

• Right click in any displayed graph to bring up a functions menu (see Figure 8.4c). Click 
COLOR and select one of up to five curves, either of the two marker pairs, or one of four 
other graphic elements, and a color box appears for you to specify its color. Click 
FILTER to customize the display of a graph (not its underlying data set). For instance, a 
strip chart recording might consist of hundreds of thousands of data points while its 
display is only 512 pixels across. Filter > Type > NONE results in all data being 
displayed, effectively plotting multiple vertical axis (y-)values at each horizontal axis 
(x-)value. Select 4K, 8K, 16K or 32K Points to limit the display to 4, 8, 16 or 32 times 
1024 points. The MEAN, MAXIMUM or MINIMUM y-value per x-value is plotted based 
on Filter > Type.

• See Figure 13.3a and the accompanying notes for discussion of the SCALE option.

• The X TRANSLATE and Y TRANSLATE options allow you to redefine the X- and Y-axis 
zero points of any graph by simply adding or subtracting an offset value. To use, drag a 
vertical (for X TRANSLATE) or horizontal marker (for Y TRANSLATE) from either the 
left or right graph edge (for X TRANSLATE) or the top or bottom (for Y TRANSLATE) of 
any graph to the value you wish to redefine as zero. Right-click on the graph and click X 
(or Y) TRANSLATE in the pop-up menu. The position of the marker becomes the new 
zero point for the axis (see Figure 8.4b). To go back, right-click to activate the pop-up 
menu and de-select X (or Y) TRANSLATE. You must also de-select the option before you 
can change the offset from one you set previously.

Figure 8.4b   X Translate Example

The Parameter Controls shown in Figure 8.4a are a subset selected to be the most frequently used in 
Force Mode. Parameters appearing under the Force Mode Tab are duplicated from their standard 
locations in the other tabs; changed values are updated in both places simultaneously.

Before After
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The definitions of most parameters appearing in the Force Mode tabs are given in the Command 
Reference Manual Software Version 5.12 Revision B and the NanoScope Software Version 6 or 7 
User Guide under Force Mode (Force Tab, see Figure 8.4f) and under Panels Menu (Channels, see 
Figure 8.4f; Feedback, and Other Tabs, see Figure 8.4g).

Note: The Z-axis signal is sampled at 30kHz by NanoScope IIIa and IV(a) controllers 
while NanoScope V controllers sample the Z-axis at 40kHz. The amount of 
averaging inherent in a reported sample value depends on the SCAN RATE, its 
partition according to FORWARD VELOCITY and REVERSE VELOCITY, and the 
NUMBER OF SAMPLES selected. To calculate the number of digitized data 
points averaged to yield one (Z-position, deflection) force sample, the time 
interval of a half cycle (either extending or retracting the tip) is multiplied by 
30kHz and divided by the NUMBER OF SAMPLES.
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Figure 8.4c   Functions Menu: Right Click in Any Displayed Graph

• The display preferences selected in the graph functions menu (Figure 8.4c) are saved by 
selecting User Preferences > SAVE. Saved graph style preferences may be applied to a 
new graph by selecting User Preferences > RESTORE.

• An individual graph may be exported by selecting for Export either BITMAP (*.bmp 
format), JPEG (*.jpg format). or XZDATA (tab-delimited text).
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• To zoom in on any plot, hold down the CONTROL keyboard key, position the cursor in 
the graph and drag open the box that appears. When released, the area in the box is 
magnified to fill the plot area. Repeat as needed. Click the magnifying glass icon in the 
bottom left corner of the plot or double-click on the plot to restore the original 
magnification (see Figure 8.4d).

Figure 8.4d   Zoom In on a Force Plot

• In Force Mode, the Classic Controls Other panel is eliminated and its parameters 
distributed among the remaining tabs.

The leftmost tab in Force Mode is labeled Force Mode. Right click in the Force Mode tab to open 
the Select Custom Control Parameters panel (see Figure 8.4e) to select up to twelve parameters 
to display in the Force Mode Tab. For a detailed procedure for the same operation applied to the 
Main Tab in Scan View see the NanoScope Software Version 6 or 7 User Guide.
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Figure 8.4e   Selection (Left) and Display (Right) of Force Mode Tab Parameters

The leftmost tab in each mode contains parameters selected from other tabs, either in the same or 
another mode. The remaining tabs in each mode contain pre-selected parameters. The Force and 
Channels Tab parameters are shown in Figure 8.4f, the Feedback Tab parameters in Figure 8.4g and 
the Script Tab parameters in Figure 8.5b.
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Figure 8.4f   Force Mode: Force and Channels Tabs

In the Channels Tab, AVE. POINTS designates the number of consecutive data channel samples to be 
averaged in the display. No averaging occurs if the value of AVE. POINTS is 1. For a larger AVERAGE 
COUNT value, the data is low-pass filtered by averaging.

Channels Tab > EFFECTIVE BW is a display (you cannot input a value to it) representing the sampling 
frequency with display averaging taken into account:

                  EFFECTIVE BW =   2(NUMBER OF SAMPLES)(SCAN RATE)/(AVE. POINTS).

Note: In averaging consecutive samples in an input datastream, real, unaveraged, data is 
appended to the output datastream if there are less than the designated number of 
samples per average.

Note: A complete discussion of the effect of measurement bandwidth can be found in 
Bruker Application Note 104, “Force Resolution in Force Spectroscopy Experiments: 
Thermal Noise and Bandwidth,” available at http://bruker.com/library.

Especially at high pulling speeds, you may see an offset between the tip/sample contact region during 
extension and retraction, whether displaying a force plot with Channel 2 DATA TYPE set to Z SENSOR or 
to LOW VOLTAGE Z. This apparent hysteresis is actually an artifact caused by an electronics delay and is 
easily removed. Adjust Channel 1 PHASE OFFSET to shift vertical axis coordinates and Channel 2 PHASE 
OFFSET to shift horizontal axis coordinates until the two contact regions overlay. 

Note: The numerical values of the two PHASE OFFSET parameters can be ignored; set them 
to whatever values minimize the apparent hysteresis. Particularly when FORWARD 
VELOCITY and REVERSE VELOCITY are unequal, the same numerical value for each 
PHASE OFFSET may not correspond to an identical displacement on each axis.
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Figure 8.4g   Force Mode: Feedback and Auto Tabs

Note: If you have the Bruker vision board option installed and, while performing 
force plots rapidly, Scan View is open with VIDEO selected to display in the 
Vision Window. If force plot execution is slow, select SCOPE or LINE PLOT, 
rather than VIDEO, to disable the video display and restore speed.

8.4.1 Plotting Deflection versus Tip/Sample Separation

You may convert the Z-piezoelectric actuator signal that moves the sample stage vertically along 
with the cantilever deflection signal into a single representation of tip/sample separation and 
choose to display force curves as cantilever deflection versus this separation. In Basic Force Mode, 
select for the Channel 3 DATA TYPE: DEFLECTION VS. SEPARATION (see Figure 8.4h).

Note: The contact region of a Deflection vs. Separation force plot is typically vertical 
because the tip is constrained to press into the sample surface at a point. If the 
surface deforms under pressure from the tip, the contact region of the force plot 
deviates from vertical.
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Figure 8.4h   A Deflection vs. Separation Force Plot
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8.5 Strip Chart Display

Strip Chart Controls are provided in Force Mode (see Figure 8.5a) to acquire and display 
DEFLECTION and Z SENSOR data over extended time intervals:

START/PAUSE

          Toggle switch to initiate, or pause, respectively, (Z-position, deflection) data point 
acquisition.

QUIT

           Clears the data and returns to ramp interface.

RESET

          Discard acquired (Z-position, deflection) data points. Next acquisition starts a new chart.

Two strip chart parameters are included in the Force Tab (see Figure 8.4f):

STRIP CHART RATE

          Frequency of (Z-position, deflection) data point acquisition.

Range: 20kHz. Typical value: 1kHz.

STRIP CHART SIZE

          Time interval over which (Z-position, deflection) data points are displayed.

Typical value: tens of seconds.

Note: Although the strip chart collects and displays data over the time interval 
defined by clicking START, then later, STOP, this data is not saved for 
subsequent use until the CAPTURE icon (shown) is clicked. If CAPTURE is 
clicked while strip chart data is being taken, what is saved begins at the start of 
the chart (sooner than the icon is clicked).
MultiMode PicoForce Manual Rev. F



Pulling: Operation
Strip Chart Display
Figure 8.5a   The Strip Chart Display

8.5.1 Scripting Mode

Scripting is provided to develop complex pulling sequences for unfolding large molecules.A 
feature is included, FETCH MOLECULE, that enable you to “catch” a single molecule between the 
tip and the surface. You can unfold and refold by ramping Z or you can hold the molecule under 
constant force or subject it to a defined ramp force. Scripting mode runs in real time and uses 
parameters set in other Real Time tabs. If you experience difficulty setting a parameter in Script, 
check parameter settings in Real Time Scan-Single.

Note: The Script Tab parameters (see Figure 8.5b) for Z-axis pulling are not to be 
confused with NanoScript, a C/C++ programming language-like aid to in-XY-
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plane lithography operations using an SPM. Refer to the Nanolithography 
manual or contact Bruker for information about NanoScript.

Figure 8.5b   Force Mode: Script Tab

Script Tab parameter definitions:

SEGMENT

          The numerical order of the script.

Range and Settings: 1 - 100.

REL X OFFSET

           X offset relative to the current position. REL X OFFSET is applied before the ramping portion 
of a segment.

REL Y OFFSET

           Y offset relative to the current position. REL Y OFFSET is applied before the ramping portion 
of a segment.

RAMP CHANNEL

           The parameter being ramped.

Range and Settings: Z SCAN or SETPOINT.
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Note: When RAMP CHANNEL = SETPOINT, the deflection signal that is displayed is 
actually DEFLECTION minus SETPOINT. Consequently while RAMP SETPOINT is 
running, the DEFLECTION is zero. Figure 8.4f shows INPUT 3 selected rather 
than DEFLECTION, The DEFLECTION signal (before setpoint subtraction) was 
patched from the front panel of the PicoForce Controller to the Aux Input 3 
BNC connector on the back of the NanoScope IV Controller.

SEGMENT TYPE

         The type of segment.

Range and Settings: RAMP ABSOLUTE or RAMP RELATIVE.

INTEGRAL GAIN

           User settable for RAMP CHANNEL = SETPOINT.

PROPORTIONAL GAIN

           User settable for RAMP CHANNEL = SETPOINT.

START RAMP

          The initial sample platform Z SCAN position or SETPOINT voltage at the beginning of a 
segment.

Range and Settings: ±10ΜM.

END RAMP

          The final sample platform Z SCAN position or SETPOINT voltage at the conclusion of a 
segment.

Range and Settings: ±10ΜM.

DELTA

           User settable for SEGMENT TYPE = RAMP RELATIVE.

RAMP VEL.
          Speed at which the tip is moved along the Z-axis during a RAMP CHANNEL = Z SCAN script 
segment or the rate at which the Setpoint is ramped in a RAMP CHANNEL = SETPOINT segment.

Range and Settings: 1NM/S - 200ΜM/S.

DELAY

          Causes the sample platform position to remain unchanged for a time interval following the 
motion induced by the current script segment. If the preceding SEGMENT was a SETPOINT ramp, 
FEEDBACK remains on the ending deflection value during the DELAY.

Range and Settings: 0 - 32,000 seconds.

BACK TO

          A looping mechanism for scripting which causes script execution to continue, not at the 
subsequent segment, but at an earlier segment whose SEGMENT value matches the current segment 
BACK TO value. After executing the earlier segment, its subsequent segment is executed. 
Eventually, the segment with the active BACK TO is reached again. Branching back is performed 
LOOP COUNT times successively; thereafter the segment BACK TO has no effect until the script is 
run again.
Rev. F MultiMode PicoForce Manual 63



Pulling: Operation
Strip Chart Display

64
Range and Settings: 0 - N-1, where the current SEGMENT value is N.

Note: Loops can not be nested.

LOOP COUNT

          The BACK TO loop counter: designates the number of times to branch back to an earlier 
segment upon reaching the segment with a nonzero LOOP COUNT value.

Note: If COUNT = 0 in a segment, then GO TO in that segment has no effect, 
regardless of its value.

Range and Settings: 0 - 32,000.

Script button definitions (see Figure 8.5b, bottom:

ADD

          Causes the current settings of the Script Tab to define a new segment which is added to the end 
of the script.

DELETE

          Prompts for a range of SEGMENTs to be removed. Subsequent SEGMENT values are 
decremented to maintain segment ordering.

RUN

          Execute the current script of sequential segment tip motions.

FETCH MOLECULE

          FETCH MOLECULE enables the user to go to the surface, grab a molecule and put Z into 
feedback at that force. FETCH MOLECULE moves to the FORWARD TRIGGER THRESHOLD, retracts 
to the REVERSE TRIGGER THRESHOLD and then goes into feedback to maintain the setpoint. An 
example of FETCH MOLECULE is shown below.   

1. In the Script tab, input a FORWARD and REVERSE TRIGGER THRESHOLD. You may want to 
take a force curve to facilitate setting these parameters. See Figure 8.5c.

2. Click FETCH MOLECULE. This will stop, if running, the Strip Chart, and run the tip toward 
the sample surface unit the FORWARD TRIGGER THRESHOLD is reached. The tip will then 
retract until it reaches the REVERSE TRIGGER THRESHOLD. If it doesn’t find the REVERSE 
TRIGGER THRESHOLD (an adhesion), FETCH MOLECULE will keep trying until it does.

3. Once FETCH MOLECULE succeeds in catching a molecule, FETCH turns on feedback at the 
REVERSE TRIGGER THRESHOLD and starts a Strip Chart. It t captures the successful “fetch 
event” as a regular force curve file, shown in Figure 8.5d.

4. Clicking RUN will then run a Script, shown in Figure 8.5c. The results of this Script are 
shown in Figure 8.5e. Segment 1 holds the molecule for 15 seconds at constant force. 
Segment 2 retracts by 1um at 499nm/sec. Segment 3 returns to the start position.

Note: If you wish to hold a molecule under constant tension, choose RAMP RELATIVE 
with DELTA = 0 and a DELAY for as long as you wish to hold the molecule.
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Figure 8.5c   Fetch Start
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Figure 8.5d   Fetch Molecule Strip Chart
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Figure 8.5e   Fetch Script
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A script example is shown in Figure 8.5f. Segment 1 ramps Z by 1.5ΜM at a velocity of 200NM/S. 
Segment 2 ramps the setpoint up by 0.5V at a velocity of 100MV/S. Segment 3 ramps the setpoint 
down by -4.0V at a velocity of 10V/S and holds it for 10.0SEC. Segment 4 ramps Z by 1.0ΜM 
at a velocity of 2.0ΜM/S. Segment 5 returns to the starting position.

Figure 8.5f   Script Example

Note: If ramping the SETPOINT more negative (i.e. increasing the tension on a 
molecule), the molecule may break or release from the probe tip. The piezo 
scanner will fully retract in an attempt to reach the desired adhesion. This is 
normal. Including an a RAMP ABSOLUTE of the Z SCAN channel to 0 as the last 
segment will return the piezo to the starting point.

8.5.2 PicoAngler Mode

The PicoAngler, shown in Figure 8.5g, provides a novel interface, modelled on the experience of 
fishing, for “catching” a molecule, pulling on it and feeling its resistance to unfolding from its 
resting position on the sample platform. The handheld PicoAngler displays numerically the Z-
position offset added by the PicoAngler and, in digital light bars, cantilever deflection, force 
sensitivity and step sensitivity. The controls that the PicoAngler provides are: Z-POSITION (with 
simultaneous force feedback), FORCE SENSITIVITY and STEP SENSITIVITY. Each of these is 
described below.

1
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• Z-position digital readout—displays in nanometers over a range of ±20µm, from fully 
extended (positive) to fully retracted (negative), the current Z-offset which the 
PicoAngler is adding to the Z-signal coming from the NanoScope Controller.

Note: The PicoAngler adds a voltage to the low voltage Z signal coming from the 
NanoScope Controller before it is amplified in the closed loop Z-axis circuitry 
of the PicoForce Control Module. The low voltage Z signal from the 
NanoScope Controller can vary over ±10V, which corresponds to the full range 
of the PicoForce Scanner Z-range. The PicoAngler can add an offset to this 
voltage sufficient to move the Z-position anywhere in its range, regardless of 
the current value coming from the Nanoscope. For example, if the NanoScope 
voltage is at -10V (fully retracted), the PicoAngler can add 20,000nm (~20V) to 
that value in order to fully extend the stage. So while the PicoAngler is capable 
of adding ±20,000nm, you will only use the maximum PicoForce offset if the 
NanoScope Controller is fully extended or retracted. During normal operation 
when the NanoScope is directing the Z-stage to be near the middle of its range 
(~0 V), the useful range of the PicoAngler will be about ±10,000nm, 
corresponding to the ~20um range of the PicoForce Z-stage. Continuing to turn 
the knob when the stage has already reached its limit will not damage the unit 
in any way, but the position offset indicated by the LCD display on the 
PicoAngler will be inaccurate.

• Relative deflection display—is indicated by the horizontal light bar. A tip deflected 
downwards by attraction to the sample moves the light to the left of center (blue). A tip 
deflected away from the sample by contact with it moves the light to the right of center 
(red).

• FORCE SENSITIVITY knob—adjusts the strength of force feedback felt while turning the
Z-position knob. The selection, 1, 3, , or  30, is indicated on the associated 
vertical 4-position light bar.

• STEP SENSITIVITY knob—adjusts the range of Z-motion in one full revolution of the
Z-position knob. The selection, 1, 3, , or  30, is indicated on the associated 
vertical 4-position light bar.

• Z-position knob—adjusts the sample platform proximity to the probe in realtime while 
resisting adjustment in proportion to the induced deflection of the cantilever.

Note: Manual control is ideal for exploratory force plots. Use the PicoAngler to bring 
the sample platform toward the tip arbitrarily slowly, then feel the cantilever 
deflect decidedly when the tip and sample begin to interact. Once the tip is 
pressed into the sample and deflecting monotonically as the platform is raised 
still further toward the tip, the decision to begin to retract is informed by tactile 
feedback, the Z-position Readout on the PicoAngler and displayed realtime 
force plot. For multiple force plots, triggered basic or scripted force plots may 
produce more repeatable results than the PicoAngler simply because the sample 
platform movement is pre-defined, so identical with each repetition.
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Figure 8.5g   The PicoForce PicoAngler

Directing a Force Plot Under Full Manual Control with the PicoAngler

Using the procedure below, you can make and record manual force curves by using the PicoAngler 
to control the tip-sample separation. When using the PicoAngler in this way, the Strip Chart Mode 
data collection is used, as described in the previous section.

1. Click PicoForce Controls > ANGLER ENABLE to activate PicoAngler (see Figure 8.4a).

Note: Verify switch on PicoForce Control Module is set to ANGLER INPUT.

CAUTION: The PicoAngler adds a voltage to the Z-piezo drive 
signal otherwise set through the NanoScope software. 
The PicoAngler contribution, as displayed in 
nanometers by the Z-position digital readout (see Figure 
8.5g) should be near zero when first engaging the 
microscope. This is most easily accomplished in Force 
Mode View by clicking PicoForce Controls > ANGLER 
RESET to zero the Z-position offset (see Figure 8.4a) or 
by manually turning the knob.

Z-position offset

Cantilever Deflection
           indicator

Force Sensitivity display

Step Sensitivity display

Force Sensitivity adjust

Step Sensitivity adjust

Z-position adjust

INPUTS

OUTPUTS

added by PicoAngler
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2. Click the ZERO SETPOINT button to set the noncontact force.

3. Click Strip Chart Controls > START (see Figure 8.4a).

Note: Click Strip Chart Controls > RESET if the top or middle graph windows display 
anything from prior strip chart recording.

Note: You may set the SAMPLE RATE and DISPLAY SIZE in the force menu.

4. Turn the Z-position adjust knob (see Figure 8.5g) clockwise to move the sample platform 
toward the tip.

Note: Positive deflection is signalled by red lights to the right on the Cantilever 
Deflection indicator. Negative deflection is signalled by blue lights to the left 
on the same indicator.

5. Feel the force feedback through the Z-position adjust knob as the tip and sample interact. The 
top Force Mode View graph displays cantilever deflection as a function of time; the middle 
graph displays sample platform Z-position as a function of time.

Note: The PicoAngler Z-position readout also displays sample platform Z-position in 
nanometers according to the same conventions:

a. A negative Z-axis motion separates tip and sample. A positive Z-axis motion brings tip 
and sample closer together.

b. The middle Force Mode graph plots absolute Z-position, where Z=0 roughly in the 
middle of the range of Z-axis travel. The PicoAngler Z-position readout displays 
relative Z-position, where Z=0 at the sample platform position when Picoforce Controls 
> ANGLER RESET was last clicked.

6. Continue to press tip and sample together to as high a cantilever deflection as desired 
(keeping in mind sample fragility, laser alignment and cantilever fragility).

7. Turn the Z-position adjust knob counterclockwise to retract the sample from the tip. 
Continue until you no longer feel or observe tip/sample interaction.

8. Click STRIP CHART CONTROLS > PAUSE to terminate (Z-position, deflection) data 
collection and freeze the three graphs.

9. The bottom graph displays a force plot by pairing data points determined at the same time on 
the top and middle graphs. The entire time interval is used in the force plot.

10. To zoom in on the force plot, position the cursor over either the left or right edge of either the 
top or middle graph, then drag a line marker into the graph. Repeat the action to provide a 
second marker line. Position the marker lines to bracket the time interval of interest in both 
the top and middle graphs simultaneously. The (bottom) force plot is redrawn, restricted to 
the subinterval of time defined by the markers.
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Note: To zoom into the top or middle graphs to better view detail, press CONTROL on 
your keyboard and use the mouse to drag a box around the area you want to 
zoom. To zoom out: double click inside the graph.

Using the PicoAngler in Conjunction with Basic Force Plots

Besides being used as a tool for fully manual force curves, the PicoAngler is also very useful 
during basic force curves. In basic force curves, if no trigger is set and the continuous ramp button 
is clicked, the piezo begins to ramp up and down around the defined Z START position. This may 
not result in a force plot if the automated ramping is not bringing the tip close enough to the 
sample. Before PicoForce, the only way to guarantee force plot generation was to manually adjust 
the Z START position parameter in software or else define a trigger and turn on the “auto-offset” 
feature to find the surface. With the PicoAngler, however, you can conveniently and quickly find 
the surface by enabling the PicoAngler, beginning continuous force ramps in Basic Force Mode, 
and then using the PicoAngler to reduce the ramping tip-sample separation. This is functionally 
equivalent to moving down the Z START position, but it is more convenient since you only have to 
turn the knob instead of manually adjusting a numerical parameter. The force-feedback feature of 
the PicoAngler knob also makes it clear when you have found the surface. There, use the 
PicoAngler to fine-tune the offset of the force plot (how much of it occurs on the surface and how 
much is the retraction). You may find this a convenient alternative to using triggers in some 
applications. 

8.5.3 Switching Between Imaging and Force Modes

The range of cantilever deflection and the manipulation of the probe typically differ between Image 
Mode and Force Mode. For instance, see Deflection Signal Clipped at Top of Plot, page 119 for a 
comparison of the range of cantilever deflection in the two modes.

In switching between Force Mode and Image Mode, the role of the deflection setpoint changes. In 
Force Mode, one typically clicks ZERO SETPOINT with the tip away from the sample to associate 
zero applied force with the unengaged cantilever deflection. Before switching to Contact Mode 
Imaging, increase the Feedback Tab > DEFLECTION SETPOINT from its near zero value. A setpoint 
near zero in Contact Mode imaging can prevent engagement because the undeflected state achieves 
the setpoint value. A positive setpoint value requires the cantilever to be deflected by the sample to 
reach the goal of the applied force control system.

CAUTION: While the PicoAngler is helpful in tip/sample 
engagement in Basic Force Mode, once on the surface, if 
not using the PicoAngler for a while, you may want to 
disengage it to avoid the possibility of accidentally 
bumping the Z-position adjustment knob when tip/
sample separation is being controlled independently.
MultiMode PicoForce Manual Rev. F



Pulling: Operation
Strip Chart Display
8.5.4 External Input Mode

Control of the sample platform Z-position may also be directed from a signal external to the 
MultiMode PicoForce system. The external input voltage is added to the Z-position voltage coming 
from the NanoScope Controller as is done with the PicoAngler offset voltage. Like the PicoAngler, 
the voltage applied with the external input can range within ±10V, but this voltage has twice the 
sensitivity of the voltage coming from the NanoScope Controller. Hence, ±5 V covers the full range 
of the Z-piezo provided the input voltage from the NanoScope Controller is 0V. The ±10V range is 
provided so that the full range of the piezo can be used regardless of the NanoScope voltage. For 
example, if the NanoScope is directing the Z-piezo to fully retract (-10V), then an applied external 
voltage between –10V and 0V has no effect because the piezo is already at –10V. External voltages 
between 0 and 10V cover the full range, 0V being fully retracted (-10V + 2*0V= -10V), and 10 V 
being fully extended (-10V + 2*10V= 10V). This final voltage controlling the Z-piezo can be 
monitored on the MODIFIED LV OUTPUT on the front panel of the PicoForce Control Module.

Note: It is possible to use the external input in conjunction with basic force curves as 
described for the PicoAngler in Using the PicoAngler in Conjunction with 
Basic Force Plots, page 72. However, take care to avoid tip/sample damage.

To direct sample Z-position externally:

1. Toggle the switch on the PicoForce Control Module front panel from ANGLER INPUT (the up 
position) to USER INPUT (the down position, see Figure 5.1a).

2. Attach to the adjacent connector labelled MANUAL OFFSET INPUT the BNC cable that will 
carry the external signal.

3. Click Strip Chart Controls > START (see Figure 8.4a).

4. Turn on the external Z-axis piezo drive input signal. Monitor cantilever deflection and 
sample platform Z-position on the top and middle Force Mode graphs, respectively.

5. When the desired tip/sample interaction data has been collected, turn off the external Z-axis 
piezo drive input signal.

6. Click Strip Chart Controls > STOP.

CAUTION: When using the external input there are no safeguards against 
overextending the piezo and damaging the tip and or sample. The 
LCD display on the PicoAngler shows the offset being externally 
applied and the 20-bar LED display shows the realtime deflection. 
Carefully monitor tip deflection to avoid tip/sample damage.

CAUTION: The external signal should be at ground potential (0V) initially to 
prevent premature sample platform motion. When the signal is 
switched on, it should be constrained to stay within ±10V, which 
spans the full range of available Z-axis movement, from fully 
retracted to fully extended.
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Note: The same steps 8 and 9 of the PicoAngler procedure (see page 71) to optimize 
the force plot apply to externally directed Z-positioning as well.

8.5.5 Auto Mode

The Auto Mode, shown in Figure 8.5h, allows the user to predefine grid points which are then used 
to acquire force curves. The user defines a grid of N ROWS by M COLUMNS with corresponding 
ROW STEPs and COLUMN STEPs. 

Note: The maximum number of ROWS or COLUMNS is a function of tip position as 
well as the ROW STEP or COLUMN STEP:

The force curves are taken at (x,y) locations centered about the current tip position. Start the Auto 
force curves by clicking the AUTO RAMP icon, shown at left, in the tool bar. The tip is moved in x, 
along a row, incrementing the TRIGGER THRESHOLD by the THRESHOLD STEP for each new x. The 
TRIGGER THRESHOLD is reset at the beginning of every row. An abort button showing the current 
tip position is displayed while the Auto force curves are running. Each force curve is saved 
individually, using the capture file name (incremented for each curve), as a single force file. The 
force curves can be opened using the Multiple Curve Analysis (MCA) feature in PicoForce 
described in Analyzing Multiple Force Plots, page 89.

Figure 8.5h   Auto Panel
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8.5.6 Point and Shoot View

The Point and Shoot View allows you to select specific points on an image (see Figure 8.5i). Use 
Point and Shoot to capture an image and/or collect a force curve for every point you designate. 

When you click a point on an image, a crosshair (+) marks the location. You can designate 
individual points, or use the tools in the Point and Shoot dialog box to assign multiple points 
simultaneously. 

Figure 8.5i   Point and Shoot Dialog Box

Image/Scan Parameters

Image/Scan Allows you to select points and capture images of each 
point.

Ramp/Force Curve Allows you to select points on an image, ramp each point, 
and create a force curve for each point.

Image Channel Select the channel to use for the image.

Ramp Channel Select the channel to use for the ramp.

Capture Image and 
Ramp

Click this button to ramp the each point, capture an image 
and save it in the Capture Directory.
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Capture Image Click this button to capture an image and save it in the 
Capture Directory.

Ramp Click this button to ramp each point.

Capture Click this button to ramp each point and capture the image 
and save it in the Capture Directory.

Point Parameters Image Cursor Mode Settings:

Mark Only—Select points of interest on the image.

M/Ramp—Select points of interest. Software will auto-
matically ramp each point.

M/R/Capture—Select points of interest. Software will 
automatically ramp each point and capture an image.

Line Parameters Draw a line to select specific points on an image.

Point Number—Number of points in the line.

Spacing—The distance in nm between each point. All 
points are equidistant.

Clear Path—This button clears the current line and asso-
ciated points.

Convert to Points—Places a + in the location of each 
point in the line. The line disappears.

Box Parameters Draw a box in the area you want to place a group of points. 
You can use the parameters below to create a grid of 
points.

Row Number—Designates the number of rows of points 
in the grid.

Column Number—Designates the number of columns of 
points in the grid.

Row Space (nm)—Designates the distance in nm between 
each row of the box.

Col Space (nm)—Designates the distance in nm between 
each column of the box.

Clear Path—This button clears the current box and asso-
ciated points.

Convert to Points—Places a + in the location of each 
point in the grid. The box disappears.

Clear All Marks Removes all user-defined marks from the Point and Shoot 
image.

Save Marked List... Save the marks on the image as Path Files (*.psm).

Load Marked List... Open a previously saved Path File (*.psm) which contains 
marks on a Point and Shoot image.
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8.6 Realtime Analysis

By enabling CAPTURE while operating in RealTime, the three plots of a Force Mode session are 
named and saved. Most analysis of data taken in Force Mode is performed after acquisition rather 
than in realtime. A handy exception is determination of the conversion factor from cantilever 
deflection in volts to nanometers as described next.

8.6.1 Determine Deflection Sensitivity in Force Mode

Deflection sensitivity should be recalculated whenever the laser beam path changes due to laser 
alignment, probe change or re-seating or photodetector adjustment.

With a force plot displayed in Force Mode, drag two markers in from the left and/or right edges and 
position them as far apart as possible while both still within the contact region of the force plot. 
Click the DEFL. SENS. button in the Force Mode Tab (see Figure 8.4e). You are asked whether you 
accept the calculated value (see Figure 8.6a).

Figure 8.6a   Deflection Sensitivity Determination in Force Mode

8.7 Determine Cantilever Spring Constant by Thermal Tune

The Thermal Tune method (see Measuring Thermal Noise, page 42) provides an automated and 
quick determination of cantilever spring constant.

CAUTION: Make sure the probe is withdrawn adequately from the sample before 
activating Thermal Tune. The probe should not interact with the 
sample during its self-excitation under ambient conditions. Four or 
five clicks of the WITHDRAW icon (shown) is sufficient to elevate the 
tip.
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Determine the cantilever spring constant by the thermal tune method according to the following 
procedure:

1. Determine cantilever deflection sensitivity if you have not done so already (see Determine 
Deflection Sensitivity in Force Mode, page 77).

Note: A correction factor should be applied to this calibration. In air, the cantilever is 
constrained at only one end, but the cantilever is constrained at both ends when 
on a surface. The cantilever bends differently in the two situations and thus 
reflects the laser beam of the optical lever differently. When you calibrate the 
deflection sensitivity using a static force, you underestimate the amplitude of 
dynamic motion by approximately 8%. This correction factor is applied in the 
thermal tune panel (Figure 8.7c) (DEFL. SENS. CORRECTION).

2. WITHDRAW (click WITHDRAW 4 times).

3. Click THERMAL TUNE in the RealTime View (see Figure 8.7a).

Figure 8.7a    Thermal Tune

4. Select a frequency range over which you will tune (see Figure 8.7b) (Applicable only to the 
NS V controller. NS IIIa and NS IV(a) controllers are limited to a THERMAL TUNE RANGE 
of 1-30kHz.)

Figure 8.7b   Select Thermal Tune Frequency Range

5. Click GET DATA in the Thermal Tune panel (see Figure 8.7c).
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6. The microscope will acquire data for about 30 seconds.

Figure 8.7c      The Thermal Tune Panel

Note: Thermal Tune computes the spring constant from the “Filtered Deflection” 
signal (see Signals Available via the PicoForce Control Module, page 116).

7. A power spectral density (PSD) plot of the cantilever response to ambient conditions is 
displayed. Click either AIR or FLUID to select a Lorentzian or a simple harmonic oscillator 
model, respectively, of the PSD to be least squares fit to the data.

Note: The equations used to fit the filtered data are:

Simple Harmonic Oscillator, for use in fluid

where:     A() is the amplitude as a function of frequency, 
                A0 is the baseline amplitude

                ADC is the amplitude at DC (zero frequency)

               0 is the center frequency of the resonant peak

                Q is the quality factor

A   A0 ADC

0
4

0
2 2– 

2 0
22

Q2
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----------------------------------------------+=
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                                               Lorentzian, for use in air

where:     A() is the amplitude as a function of frequency, 
                A0 is the baseline amplitude

                0 is the center frequency of the resonant peak

                C1 is a Lorentzian fit parameter

                C2 is a Lorentzian fit parameter

8. Version 7 software: Adjust the MEDIAN FILTER WIDTH, shown in Figure 8.7d, to remove 
individual (narrow) spikes. This replaces a data point with the median of the surrounding n (n 
=3, 5, 7) data points.

Figure 8.7d   MEDIAN FILTER WIDTh

9. Version 7 software: Adjust the PSD BIN WIDTH to reduce noise by increasing the averaging.

10. Drag markers in from the left and/or right plot edges to bracket the bandwidth over which the 
fit is to be performed.

Note: Typically the markers are located roughly where the spectrum rises from the 
noise floor. Precise placement is unnecessary; the fit is insensitive to the 
minimal power contributed from these frequencies far from the natural 
resonance (see right “shoulder” of waveform, Figure 8.7c). You may exclude a 
larger portion of a shoulder of the waveform from the fit bandwidth to ignore a 
noise spike (see left shoulder, Figure 8.7c). Experiment with repeated fits of the 
same acquired thermal tune data to become familiar with its sensitivity to 
bandwidth and choice of model.

11. Click FIT DATA. The curve fit is displayed along with the acquired data.

A   A0

C1

 0– 2 C2+
----------------------------------+=
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12. Adjust the markers for the bandwidth of the fit PSD to include in the spring constant 
calculation.

Note: While the goal of setting the bandwidth for the curve fit was to achieve the 
highest signal-to-noise ratio by excluding noise, in setting the bandwidth for 
spring constant calculation from the (noise-free) fit curve the objective is to 
include all frequencies that contribute power to the spectrum. For instance, if 
you left out part of a shoulder in performing the curve fit, include it in 
determining the spring constant (see Figure 8.7e).

13. Enter the cantilever TEMPERATURE.

14. Click CALC. SPRING K. You will be asked whether you want to accept the calculated value 
of the spring constant, k (see Figure 8.7e).

Figure 8.7e   Bandwidth for Spring Constant Calculation

See Problems with Thermal Tune, page 120 for troubleshooting tips.
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Chapter 9   Pulling: Offline Analysis
RealTime and Offline modes can operate concurrently in Versions 6 and 7 of NanoScope software, 
so are not distinguished as they were in previous versions.

Note: Offline functions operate more slowly when the SPM probe is engaged with a 
sample. Withdraw the probe to speed up nonrealtime activities.

Force plot files are named and saved in the same way as scanned image files. NanoScope Version 6 
and 7 software features a dockable file browsing window initially at the right edge of the client 
window (see Figure 9.0a).

Note: Many subpanel edges are movable. Position the cursor over an edge and watch 
for the cursor appearance to change to a line segment with arrows at each end. 
Then drag (click and hold while moving the cursor) to re-position the dragged 
edge. For instance, the column widths (Name, Size, Type, etc.) can be re-sized 
as well as the window in which they appear itself.

Click the box to the right of the word DIRECTORY in the file browsing window to locate a folder in 
the directory listed to the right of the box. Selecting the first icon in the upper left of the file 
browsing window initiates a text presentation of file information (as in Figure 9.0a). The second 
icon in the upper left of the file browsing window causes thumbnail presentation of image files as 
illustrated in Figure 9.0b (the icon has been scrolled out of view at the top of the window of 
images). Click on a thumbnail to open the image for further analysis. The third icon in the upper 
left of the file browsing window displays file information, in either text or thumbnail presentations, 
of the capture directory (D:\capture).

Figure 9.0a   Browse for Folder Window Open Upon Clicking Directory
Rev. F MultiMode PicoForce Manual 83



Pulling: Offline Analysis

84
Once an image is open, traditional Offline image analysis icons appear (see Figure 9.0b) in the 
toolbar to the right of the Help icons (“?”). Refer to the Command Reference Manual and 
NanoScope Software Version 6 and 7 User Guide for description of their functions. From left to 
right, they are: Image, Depth, Section, Roughness, 3D Surface Plot, PSD, Zoom, XY Drift, 
Flatten, Planefit, Median, Low Pass and Erase.

Figure 9.0b   Click an Image on the Right to Open It in the Central Client Window

When a force file is opened (rather than an image file) from the file browsing window, opening it 
causes the three constituent plots to be displayed (see Figure 9.0c).

Note: The same functions menu, opened by right click in the image, is available here 
in Image Processing Mode, just like in RealTime Mode (see Figure 8.4c and 
accompanying notes, such as for zooming in and out of a plot). For instance, 
select EXPORT to save a plot elsewhere in bitmap or JPEG format. Comma-
delimited text format will also soon be available.

Two pairs of markers are available on each plot. Drag from a side into a graph to make a marker 
appear. For each marker pair, the marker/curve intersections are tabulated to the right along with 
the  difference in coordinate values along each axis and the resulting slope and its inverse.

Cantilever deflection is listed in volts for each marker. If DEFLECTION SENS has been entered, 
cantilever deflection is also listed in nanometers. In addition, if a value is entered for SPRING 
CONSTANT, cantilever deflection appears as a force, in piconewtons, too.

Note: See Bruker Application Note 97, “NanoScope Software Tools for Force 
Spectroscopy Data Analysis,” available at http://bruker.com/library for a useful 
review of NanoScope Force Spectroscopy tools.
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Figure 9.0c   Offline Presentation of a Captured Force Plot

9.1 Fitting Force Plots to Models

Stored force curves may be fit to several built-in models: LINE, HERTZIAN or WORM-LIKE 
CHAIN. To perform a fit:

1. Select a force curve.

2. Set the DISPLAY MODE to DEFLECTION VS. SEPARATION.

Note: Calibrate the deflection sensitivity using a hard sample.

3. Select the appropriate ACTIVE CURVE; APPROACH for the HERTZIAN model and RETRACT for 
the WLC model.

4. If necessary zoom (see zoom, Page 55) in on the appropriate portion of the force curve.

5. Drag a pair of markers (see markers Page 84) to bound the region of interest.

6. Select the appropriate model, LINE, HERTZIAN or WORM-LIKE CHAIN.
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a. The LINE model fits outputs m and b parameters for

b. The HERTZIAN model, shown in Figure 9.1a, fits

where f(x) is the force in Newtons, x is the distance in nm, R is the radius in nm and K is the fit 

parameter with units of Newtons/nm2. This model is appropriate for pushing (Approach) a sphere 
into a hard surface.

Note: R is fixed at 1 nm. Scale for other values of R.

Figure 9.1a   Hertzian Fit

c. The WORM-LIKE CHAIN model, shown in Figure 9.1b, fits

where f(x) is the force in Newtons, x is the distance in nm, kB is Boltzman’s constant, T is 298°K, 

Lp is the persistence length (in nm) and is an input variable and L is the parameter to be estimated.
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Figure 9.1b   Worm-Like Chain Fit

7. A green curve fit will be displayed in the plot window and the least squares fit equation, with 
RMS error and deviation will be displayed in the right window.

9.2 Reviewing Multiple Force Plots

A force spectroscopy session using the MultiMode PicoForce can yield dozens if not hundreds of 
individual force plots.

1. To facilitate comparison of plots and deletion of files deemed unworthy of inclusion, click 
File > REVIEW FORCE CURVES... or right-click on a force curve in the browse window and 
click REVIEW CURVE.

2. The Review Force Curves window opens (see Figure 9.2a).

a. Enter the path to the DIRECTORY whose contents are the force plot files of interest.

b. Select a SORT category: DATE, NAME or TMR (scanning trace minus retrace).

Note: The TMR values are proportional to the area between the approach and retract 
curves.

c. Select a SORT order: ASCENDING (box checked) or DESCENDING (box unchecked).

d. Select the PLOT UNITS (vertical axis) units: VOLTS, METRIC or FORCE.

e. Select the PLOT number.

f. Select the TRACE(s) to plot: EXTEND, RETRACT or BOTH.

3. Advance through the ordered set of files by clicking the arrow buttons in the bottom left of 
the File text box or using the keyboard arrow keys.

a. Click MARK FOR DELETE, D, or the keyboard DELETE key for any force plot you wish 
to discard from the set.
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Note: Files marked for deletion are not sent to the recycling bin until the DELETE 
FILES button is clicked. You may remove the check from the MARK FOR 
DELETE at any time prior.

Figure 9.2a   The Delete Force Curves Window for Reviewing Multiple Force Plot Files

4. Zooming on a plot is accomplished by pressing CTRL, left-clicking and dragging in the plot 
area. Zooming out is done by double-clicking in the plot area.

9.3 Filtering Multiple Force Curves

Another way to quickly delete force curves uses the FILTER CURVES... function.

1. You may apply selection criteria to delete force curves by selecting, from the main menu, 
FILE > FILTER CURVES... 

2. The Filter Force Curves window opens (see Figure 9.3a).
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Figure 9.3a   The Filter Force Curves Window

a. Enter the path to the DIRECTORY whose contents are the force plot files of interest.

b. Enter the PLOT number you wish to analyze.

c. Enter a MINIMUM (x) DISTANCE from the contact point below which data will be 
ignored.

d. Enter a MINIMUM FORCE from the contact point to qualify peaks.

e. Enter the number AVERAGE POINTS to use. To reduce noise, peak values are computed 
by averaging ±(AVERAGE POINTS)/2 around a point.

3. Click DELETE CURVES to analyze, using the criteria in the Filter Force Curves window, the 
force curves in the selected directory. Click CANCEL to abort the process.

4. Files meeting the deletion criteria will be shown in the left window, shown in Figure 9.3a, 
and a message, Confirm File Delete, will be displayed asking if you wish to send the 
specified file to the Recycle Bin.

9.4 Analyzing Multiple Force Plots

Large numbers of force plots can be evaluated using the PicoForce Multiple Curve Analysis (mca) 
function.

1. Click File > New > MULTIPLE FORCE (*.MCA) or select MULTIPLE FORCE CURVES in the 
browse window, right-click and then click CURVE ANALYSIS to open a MultipleForce 
window.
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2. Click ADD FILES... in the MultipleForce window to open a file selection window and click 
the files to be analyzed (see Figure 9.4a). Click ADD. These files are then added to the file list 
in the MultipleForce window. Files in that list may be removed individually or multiply by 
clicking the file name and then clicking REMOVE FILES.

Figure 9.4a   Multiple Force Window

3. Individual or multiple files to be analyzed are selected from this list by checking the PLOT 
column. 

4. Right-clicking a file in the MultipleForce window opens a menu (shown in Figure 9.4b) that 
allows checking or unchecking all files in the list as well as functions that affect plotting 
parameters, discussed below.
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Figure 9.4b   Right-click Menu

Many display and analysis functions are available in the MultipleForce window:

• DISPLAY:

• PLOT UNITS: The user can choose either FORCE, VOLT or distance (METRIC) on 
the Y axis.

• PLOT DIRECTION: The EXTEND option plots and looks for peaks only in the 
EXTEND direction. The RETRACT option plots and looks for peaks only in the 
RETRACT direction.

Note: The EXTEND curve will still be used to find the point of contact if that option is 
selected under AUTO ALIGN CURVES -> X AXIS AUTO-ZERO.

• TYPE: Either Z or SEPARATION. Z displays the Z position of the piezo measured by 
a capacitive sensor. SEPARATION displays the corrected (for cantilever deflection) Z 
data.

• INVERT: The Y axis is inverted when YES is selected.

• PLOT: Any of three channels (see Basic Force Mode: Section 8.4) may be plotted.

• SELECT MODE: ON turns all curves to color number one and the selected (by mouse 
or arrow key) curve to its plot color.

• PEAK DETECTION:

• MINIMUM SIZE: Finds peaks greater than the value entered here.

• PERCENTAGE OF MAX: The Y variable must fall by this percentage to be 
considered a peak.

• MINIMUM WIDTH AT % MAX: A peak must have a width (at PERCENTAGE OF 
MAX of the peak’s absolute value) greater than the MINIMUM WIDTH AT % MAX 
to be considered a peak.

• AUTO ALIGN CURVES:

• X AXIS AUTO-ZERO: Either ON (at the contact point), OFF or USER. 
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• Y AXIS AUTO-ZERO: Either ON, OFF, USER or CASCADE which increments the Y 
offset of each plot by the CASCADE OFFSET.

• CASCADE OFFSET: Define the Y offset to be used here when the Y AXIS AUTO-
ZERO is set to CASCADE.

Many data plotting commands are accessible by right-clicking in the plot area, shown in Figure 
9.4c:

Figure 9.4c   Plot Command Menu: Right-Click

Additional data plotting commands are initiated by keystrokes:

• Zooming on a plot is accomplished by pressing CTRL, left-clicking and dragging in the 
plot area. Zooming out is done by double-clicking in the plot area or clicking the 
magnifying glass at the lower left corner of the plot.

• Arrow keys move a plot by an increment defined by the Set Increments menu.

Figure 9.4d   Set Increments and Set Offset Menus
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The following buttons, below the plot window are available: 

• ADD FILES...:Opens a file selection window that allows files to be added in the 
Multiple Force window.

• REMOVE FILES:Deletes selected (by clicking) files from the Multiple Force window.

• FIND PEAKS: Finds peaks using the filters (rules) selected in the PEAK DETECTION 
functions to the right of the plot window. The X OFFSET and Y OFFSET, PEAK NUMBER, 
X VALUE, Y VALUE, PEAK-TO-PEAK and DY VALUEs are shown in the table below the 
plot window, as shown in Figure 9.4e.

• REFRESH: Used to refresh the plot window after selecting or deselecting files or 
changing inputs.

• EXPORT...: Saves the results from FIND PEAKS in a tab-delimited text file.

Figure 9.4e   MCA: Find Peaks
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9.5 Exporting Force Plot Files

Stored images (see Figure 9.0b) and force plots (see Figure 9.0c) can be included in thumbnail 
format in the Browse window on the right of the PicoForce display screen. From there, files may be 
selected for export. If a force curve is open, its data may also be exported by clicking FILE > 
EXPORT > ASCII.

1. Click View > BROWSE.

2. Enter the path to the directory of interest at the top of the Browse window to select what is 
displayed. Drag the left edge of the window to the left to expand the window as needed.

3. Select the file(s) of interest.

Note: The keyboard CONTROL and SHIFT keys have familiar capabilities here. 
Multiple files are included in a single selection by holding down CONTROL 
while clicking on each item. Consecutive files are selected by clicking on the 
first one, holding down the SHIFT key and clicking on the last one.

4. Within the selection, right click to display a menu with options: OPEN, EXPORT, DELETE, 
AUTO PROGRAM and CURVE ANALYSIS. Click EXPORT > ASCII.

5. In the Export window check the boxes that apply:

a. Click EXPORT TIME to include the horizontal axis data from Channels 1 and 2, the 
sources of the vertical and horizontal axis data, respectively, of a force plot (Channel 3).

b. Check the units preferred for DEFLECTION data (volts, nanometers or piconewtons).

c. Check the units preferred for Z SENSOR data (volts or nanometers).

d. Check which TRACES to include: (at least one of) EXTEND and RETRACT.

e. Check EXPORT HEADER for inclusion of more detail on the conditions during data 
taking.

6. Click SAVE AS... to export the selected files.

7. In the SAVE AS... window provide a path to a directory and choose a file extension type to 
designate the file format.

Note: If no file extension is provided, files are stored as text files (*.txt, see
Figure 9.5a).

Note: If more than one file are selected, a batch export is performed automatically.
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Figure 9.5a   The Data Export Window and (the Beginning of) a Sample Data File

Force files may also be exported as a BITMAP or JPEG image file or as an XZ DATA file by right-
clicking in the plot window.
Rev. F MultiMode PicoForce Manual 95



Pulling: Offline Analysis
Exporting Force Plot Files

96
 MultiMode PicoForce Manual Rev. F



Chapter 10   Pushing: Theory and Principles
10.1 Types of Pushing Applications

MultiMode PicoForce can be used to push as well as to pull a sample. A typical application is 
indentation: deliberate pressing into a surface to measure how it yields to pressure. Force plots, 
which entail both pushing and pulling, can be viewed as an application in the transition region 
between molecule pulling and nanoindentation. In particular, force plots are often performed on 
soft samples specifically to establish an upper bound on the pressure that may be applied before the 
sample is crushed or punctured. A force plot on a soft sample lacks a linearly sloped contact region 
(region 3 in Figure 7.1a) in which to define force sensitivity.

Note: For applications emphasizing in-sample-plane pushing, as opposed to out-of-
the-sample-plane pushing, the NanoMan Option with a Dimension SPM may 
be preferable due to its closed loop XY-positioning of the tip. MultiMode 
PicoForce features closed loop Z-positioning of the sample.

An indentation force plot can be used to estimate the elastic modulus of a sample. A simple 
relationship has been shown to exist among contact stiffness, contact area and elastic modulus that 
is independent of the shape of the indenter used.

Other reasons to apply a force to a sample are deliberate scratching and wear testing, both of which 
add elements of scanning to the basic indentation process.

10.2 Analysis of Indentation Force Plots

The traditional force plot shown in Figure 7.1a illustrates an unyielding surface: the cantilever 
deflects linearly with applied force and follows the same trajectory retracting from the sample. 
Such a plot on a hard surface is ideal for establishing DEFLECTION SENS. In a typical indentation 
application, the surface yields to pressure and is crushed directly under a diamond tip. Thus, the tip 
follows a new trajectory when retracted. The initial slope of the retraction curve portion of a force-
displacement plot is a measure of unloading stiffness, S = dF/dz. Assuming the indenter/sample 
contact area remains constant during initial tip withdrawal, the function F(z) has been found to be:

where a = the radius of the contact area,
          µ = the shear modulus of the sample and
          = Poisson’s ratio for the sample.

F
4a
1 –
------------z=
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The elastic modulus, E, of a material is related to the shear modulus and Poisson’s ratio by:

Differentiating force, F, with respect to displacement, z, completes the relationship among 
unloading stiffness, contact area and elastic modulus:

where A = ¼a2, the circular contact area with radius a.

Though originally derived for a conical indenter, the above equation has been shown to be valid for 
any indenter such that its contact surface is the body of revolution of a smooth function. Even for 
indenters with square or triangular cross sections, deviations from the relationship are by only 
approximately 1.2 percent and 3.4 percent, respectively.

Allowing for some deformation of the indenter itself as well, a reduced modulus, Er, is defined by:

where i represents the indenter: Ei = the elastic modulus of the indenter and i is Poisson’s ratio of 

the indenter. The governing relationship then transforms to:

With the above equation, measuring the initial unloading slope and the maximum area of contact 
yields the reduced elastic modulus. Because MultiMode PicoForce is an imaging platform as well 
as an applicator and measurement device for nanoscale forces, the indentation contact area is 
readily measured.

Another material characteristic measurable from indentation is hardness, H = Fmax/A, the 

maximum load divided by the contact area at peak load.

For further discussion and derivations of the above relationships, refer to “An improved technique 
for determining hardness and elastic modulus using load and displacement sensing indentation 
experiments”, by W. C. Oliver and G. M. Pharr, in the Journal of Materials Research, Vol. 7, No. 6, 
June 1992, page 1564.

E 2 1 + =

dF
dz
------ 2


------- A

E
1 2– 

-------------------=

1
Er
----- 1 2

– 
E

-------------------
1 i

2
– 
Ei

---------------------+=

S
dF
dz
------ 2


-------Er A= =
MultiMode PicoForce Manual Rev. F



Chapter 11   Pushing: Operation
Into-the-sample-plane pushing applications are generally ranked by dimensionality. Indentation 
ideally involves pressing a probe into a single point. Scratching starts with pressing in at a point 
and proceeds with dragging the probe along a line segment. Wear testing typically entails a repeated 
raster pattern of scratches. Only certain probe types are designed to withstand the stresses of higher 
dimensional pushing applications.

11.1 Probe Selection

A particularly hard probe is preferred in most pushing applications so the results can be 
unambiguously interpreted as representative of the effect of the indenter on the sample and not vice 
versa, nor a mixture of the two. Bruker supplies the DNISP type probe for pushing applications: a 
diamond-coated tip of <25nm radius mounted on a stainless steel cantilever. Compared to other 
scanning probes, a typical indentation probe has a higher spring constant for imparting larger forces 
to a sample (see Table 11.1a). DNISP probes are supplied with their spring constant specified 
within ±10%. A silicon reflector is mounted on the top side of the cantilever to obtain a well 
focused laser spot on the photodetector (see Figure 11.1a). The stiff cantilever, durable tip and 
reflector add mass relative to standard scanning probes, lowering the cantilever resonant frequency. 
Indenting probes are still useful for TappingMode imaging as well, facilitating contact area 
determination following indentation.

Table 11.1a   Probe Characteristics Comparison

The forces involved when indenting are typically in the range of 1—100N for a standard probe 
cantilever. The diamond tip is in the form of a 3-sided pyramid (plus base) with an apex angle of 60 
degrees. To promote symmetric dents, the diamond is mounted such that the vertical axis of the 
pyramid is approximately normal to the sample when mounted on the SPM.

Application
Cantilever 

Spring 
Constant

Cantilever 
Resonant 

Frequency

Contact Mode scanning 0.01-1.0N/m n/a

TappingMode scanning 20-100N/m ~300kHz

Pushing 100-300N/m 35-60kHz
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Figure 11.1a   A DNISP Type Indenting/Scratching/Wear Testing Probe  

11.2 Indentation

A dent is made by forcing the tip into the sample surface until the required cantilever deflection is 
reached. The tip is then lifted to its initial Z position above the sample surface. For each dent, a 
force plot is recorded. You may execute an indentation array automatically using the AUTO INDENT 
command, specifying an initial force and a force increment in the X direction (and a constant force 
in the Y direction). Both the number of dents and the spacing between them—in both X and Y 
directions—can be preset.

Indentation is not presently supported in NanoScope Version 6. If you have a NanoScope IIIa 
or IV(a) Controller, exit Version 6 and start NanoScope Version 5 to perform indentation or 
scratching. If you have a NanoScope V Controller, refer to Support Note 423, Nanoindentation 
for NanoScope Software Version 7.

Single-cycle Indentation

The basic nanoindentation procedure follows:

1. Load the sample and indentation probe into the SPM.

2. Align the laser on the reflector atop the cantilever.

3. Engage the surface in TappingMode with RMS amplitude of 0.25–0.3V.

Note: Execute CANTILEVER TUNE to find the resonant frequency of the cantilever. 
Set the DRIVE FREQUENCY to the center of the resonance peak. Adjust the 
DRIVE AMPLITUDE until the RMS amplitude of the cantilever is from 0.25-
0.3V (This is significantly lower than the RMS amplitude typically used with 
standard TappingMode probes).

Note: When positioning the tip close to the sample surface before engaging, be aware 
that the diamond tip extends 100m beneath the underside of the cantilever.

4. Image the sample to locate an area of interest for indenting.
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Note: Set RealTime Scan Controls and Feedback Controls imaging parameters to 
values appropriate for TappingMode imaging. Limit SCAN RATE to about 1HZ 
for indentation probes. Engage with a small SCAN SIZE, about 1-3MM, and 
increase SCAN SIZE after engaging if necessary. The standard INTEGRAL GAIN 
and PROPORTIONAL GAIN of 0.5 and 1.0, respectively, are appropriate.

5. Click RealTime > View > Force Mode > INDENT and indent the surface.

Note: The Indent Controls, Feedback Controls, Display Controls, and Auto 
panels, and three data Channel panels open. Open the Indent Controls panel 
using the Panels menu option, if it is not already open. The parameter settings 
shown in Figure 11.2a are a good starting point for indenting a new sample. The 
TRIGGER THRESHOLD is the cantilever deflection at which the controller stops 
pushing the tip into the surface. Click RUN SINGLE (icon shown) to make a 
single-cycle indentation.

Figure 11.2a   Indent Controls Panel for Indenting

6. To save the displayed force plot, click the CAPTURE icon (shown).

7. Click View > IMAGE MODE, or click the Image icon (shown) to view the dents just created.

For more information about Indent Controls parameters also used in other SPM modes, refer to 
Support Note 225F, Nanoindentation and Nanoscratching with SPMs for NanoScope Version 4.32 
Software, or the Command Reference Manual. The X ROTATE parameter in the Indent Controls 
subpanel and INDENT SETPOINT in the Other Controls subpanel are described here because they are 
unique to pushing operations.

X ROTATE controls lateral tip motion during indentation. This is useful because the cantilever is at 
an angle relative to the surface. X ROTATE can prevent the tip from plowing the surface laterally 
due to cantilever bending or coupling of the Z- and X-axes of the piezo scanner. At engagement, the 
tip is oriented normally. However, as the tip is pressed into the surface, it tends to pitch forward. By 
applying a slight X-axis offset, the tip is brought normal again (see Figure 11.2b). X ROTATE is 
typically set between 15 and 25 DEGREES, often to 22.0 DEGREES. X ROTATE is disabled when set 
to 0 DEGREES.

Indent Controls

Z scan size:

Z scan rate:

Trig threshold:

X offset:

Y offset:

10.0 V

2.03 Hz

0.2000 V

0.00 V

0.00 V

Indent setpoint:

Start mode:

0.900

Indent

Indent Controls Other Controls

Auto ramp size: Enabled

Lift height: 200 nm

X Rotate: 22.0 deg

Units: Volts
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Figure 11.2b   Maintaining the Tip Normal to the Surface During Indentation with X ROTATE

The three images in Figure 11.2c all use the same TRIGGER THRESHOLD value and demonstrate the 
effect of X ROTATE at various settings. The dent is largest for a value of 0.0 DEGREES. Material is 
piled on the left, outboard side of each indentation depending upon the amount of correction. The 
pitching forward of the cantilever during nanoindentation tends to move the laser spot in a direction 
opposite to normal deflection. This produces reduced deflection at the photodetector for higher 
forces, the opposite of the desired mode of operation. Deeper, larger dents are made at lower X 
ROTATE values.

Figure 11.2c   X ROTATE Effect on Gold Under Constant TRIGGER THRESHOLD

1
2

3

Tapping mode

Contact mode
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The INDENT SETPOINT parameter influences the transition from TappingMode during engage to 
Contact Mode for indentation. INDENT SETPOINT only has an effect during indentation and 
scratching. With a value typically between 0.5 and 1.0 (and usually 0.9), INDENT SETPOINT 
multiplies AMPLITUDE SETPOINT to reduce its effective value during engage for indentation.

INDENT SETPOINT is useful in cases where the free-air (pre-contact) part of a force plot is not flat. 
In such cases, the maximum deflection and force during indenting vary depending on where the 
indentation is triggered. Applying the INDENT SETPOINT multiplier enables moving the surface 
contact point closer to where cantilever deflection begins (see Figure 11.2d). During the tip descent 
to the surface, the graph displays the surface contact point as a vertical yellow line.

CAUTION: If INDENT SETPOINT is set too low, the tip may be extended too far into the 
sample surface, threatening the tip. If the target oscillation amplitude is too close 
to the noise level, the tip may be pushed into the surface with the Z piezo fully 
extended. Also, if the INDENT SETPOINT parameter is set too high, the tip will be 
retracted from the surface as the control loop attempts to attain an RMS 
amplitude which is higher than the free air amplitude.

Figure 11.2d   Shifting the Surface Contact Point Using INDENT SETPOINT

Surface contact point

IndentationTrigger point

Surface contact point (shifted left)

Trigger point
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Automated Indentation Arrays

To generate an array of indentations initiated by a single command, begin with the first five steps of 
the standard single-cycle indentation procedure (last section). Then:

1. In the Auto panel (see Figure 11.2e), enter the size of the array of indents by providing the 
number of indents along the X-direction for COLUMNS, and along the Y-direction for ROWS.

2. Set the array spacing in the X- and Y-directions by entering values for COLUMN STEP and 
ROW STEP, respectively.

3. To increase the force applied with each successive indentation along the X-direction, enter a 
value for THRESHOLD STEP. The initial indentation in each row applies a force determined 
by  TRIGGER THRESHOLD. Each subsequent indentation in the row concludes at a force 
higher than the previous indentation by an amount corresponding to THRESHOLD STEP.

4. Set CAPTURE to ENABLED before executing the array if you want to store the results.

Figure 11.2e   Example Auto Panel for Automated Indentation

5. Click Probe > AUTO INDENT in the Indent Mode menu to begin execution of the array.

Note: During execution, the force plot for each indent is displayed along with the 
(X,Y) coordinates of the indent in the array.

6. Click View > IMAGE MODE, or click the Image icon (shown) to view the dents just created.

11.3 Scratching

Nanoscratching is essentially the same process as nanoindentation, except that the tip is moved 
laterally by a prescribed amount after the sample surface is penetrated. A scratch is made by 
forcing the tip into the sample surface until the required cantilever deflection is reached. Then, with 
the Z feedback turned off, the tip is moved laterally using the preset distance, direction and speed. 
The tip is then lifted to its initial Z position above the sample surface. As with nanoindentation, it is 
also possible to execute arrays of scratches automatically using the AUTO SCRATCH command.

Note: AUTO SCRATCH is not available in NanoScope version 7 software.

Auto Panel

Columns: 3

Rows:

Column step:

Row step:

3

500 nm

500 nm

Threshold step: 0.100 V

Capture: Enabled
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Figure 11.3a   Nanoscratching

Single-cycle Scratching

The basic nanoscratching procedure follows:

1. Load the sample and indentation/scratching probe into the SPM.

2. Align the laser on the reflector atop the cantilever.

3. Engage the surface in TappingMode with RMS amplitude of 0.25–0.3V.

Note: Execute CANTILEVER TUNE to find the resonant frequency of the cantilever. 
Set the DRIVE FREQUENCY to the center of the resonance peak. Adjust the 
DRIVE AMPLITUDE until the RMS amplitude of the cantilever is from 0.25-
0.3V (This is significantly lower than the RMS amplitude typically used with 
standard TappingMode probes).

Note: When positioning the tip close to the sample surface before engaging, be aware 
that the diamond tip extends 100m beneath the underside of the cantilever.

4. Image the sample to locate an area of interest for indenting.

Note: Set RealTime Scan Controls and Feedback Controls imaging parameters to 
values appropriate for TappingMode imaging. Limit SCAN RATE to about 1HZ 
for indentation probes. Engage with a small SCAN SIZE, about 1-3MM, and 
increase SCAN SIZE after engaging if necessary. The standard INTEGRAL GAIN 
and PROPORTIONAL GAIN of 0.5 and 1.0, respectively, are appropriate.

5. Click RealTime > View > Force Mode > SCRATCH and indent the surface.

Note: The Indent Controls, Feedback Controls, Display Controls, and Auto 
panels, and three data Channel panels open. Open the Indent Controls panel 
using the Panels menu option, if it is not already open. The parameter settings 
shown in Figure 11.3b are a good starting point for scratching a new sample. 
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Note the scratching-specific parameters in the Other Controls subpanel. The 
Indent Controls subpanel parameter TRIGGER THRESHOLD is lower than 
shown in Figure 11.2a for indenting. Click RUN SINGLE (icon shown) to make 
a single-cycle indentation.

Figure 11.3b   Indent Controls Panel for Scratching

6. A force plot displays (deflection as a function of Z-position, the latter changing little during 
the scratch itself). To save the displayed force plot, click the CAPTURE icon (shown).

7. Click View > IMAGE MODE, or click the Image icon (shown) to view the dents just created.

Automated Scratching Arrays

To generate an array of scratches initiated by a single command, begin with the first five steps of 
the standard single-cycle scratching procedure (last section). Then:

1. In the Auto panel (see Figure 11.3c), enter the size of the array of scratches by providing the 
number of scratches along the X-direction for COLUMNS, and along the Y-direction for 
ROWS.

2. Set the array spacing in the X- and Y-directions by entering values for COLUMN STEP and 
ROW STEP, respectively.

Note: Automated scratching uses the beginning of the scratches as the reference for 
the array. Thus, after an X and/or Y offset is performed, the scratch is made in 
the specified direction. Often, the ROWS parameter is set to 1 and SCRATCH 
ANGLE to 90 DEGREES, resulting in a row of scratches parallel to the Y-axis.

3. To increase the force applied with each successive scratch along the X-direction, enter a 
value for THRESHOLD STEP. The initial scratch in each row applies a force determined by  
TRIGGER THRESHOLD. Each subsequent scratch in the row is made at a force higher than the 
previous scratch by an amount corresponding to THRESHOLD STEP.

4. Set CAPTURE to ENABLED before executing the array if you want to store the results.

Indent Controls

Z scan size:

Z scan rate:

Trig threshold:

X offset:

Y offset:

10.0 V

2.03 Hz

0.100 V

0.00 V

0.00 V

Indent setpoint:

Start mode:

0.900

Scratch

Indent Controls Other Controls

Auto ramp size: Enabled

Scratch length: 1.00 m

X Rotate: 22.0 deg Scratch rate: 1.00 Hz

Scratch angle: 90.0 deg

Units: Volts

Lift height: 200 nm
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Figure 11.3c   Example Auto Panel for Automated Scratching

5. Click Probe > AUTO SCRATCH in the Scratch Mode menu to begin execution of the array.

Note: During execution, the force plot for each indent is displayed along with the 
(X,Y) coordinates of the indent in the array.

6. Click View > IMAGE MODE, or click the Image icon (shown) to view the scratches just 
created.

11.4 Wear Testing

Wear tests are performed by simply scanning the sample in Contact Mode using indentation 
cantilevers (see Figure 11.4a). With their spring constants more than 100 times greater than 
standard Contact Mode imaging cantilevers, indentation cantilevers cannot be used to image in 
Contact Mode. Worn areas can be imaged afterward in TappingMode with the same indentation 
probe.

Figure 11.4a   Wear Testing in a Rectangular Area

Auto Panel

Columns: 3

Rows:

Column step:

Row step:

1

500 nm

0.00 nm

Threshold step: 0.100 V

Capture: Off
Rev. F MultiMode PicoForce Manual 107



Pushing: Operation
Wear Testing

108
The basic nanowear testing procedure follows:

1. Load the sample and indentation/scratching/wear probe into the SPM.

2. Align the laser on the reflector atop the cantilever so the reflected spot on the photodetector 
produces near-zero vertical and horizontal deflection signals.

3. Set RealTime Scan Controls and Feedback Controls imaging parameters to values 
appropriate for  Contact Mode imaging. Set SCAN SIZE to 0.0 to prevent scanning/wearing 
initially, and set DEFLECTION SETPOINT within the range 0.3–0.5V to minimize the 
engage force, while ensuring engagement. Set both the INTEGRAL GAIN and 
PROPORTIONAL GAIN to a value of 2.0.

4. Manually lower the tip to near the sample prior to engaging. 

CAUTION: The diamond tip extends 100m beneath the underside of the cantilever. Focus 
on the top of the cantilever while positioning the probe.

5. Engage the surface by selecting the RealTime > Motor > ENGAGE command or the 
ENGAGE icon (shown).

6. Decrease the DEFLECTION SETPOINT by 1-2 volts to lift the tip off the surface. Check that 
the Z-piezo is retracted by looking at the image monitor. The z center position should move 
to the retracted side of the Z Center Position bar on the image monitor and the word “Limit” 
should appear in place of the Z center voltage value. It this does not occur, the Z-piezo is not 
fully retracted and the tip may still be on the surface. Decrease the DEFLECTION SETPOINT 
in 1V increments until the tip is retracted.

Note: Engaging in Contact Mode using indentation cantilevers often produces a small 
dent at the initial point of contact. Offset to a fresh location on the sample to 
perform the test if you wish.

7. Set SCAN SIZE and SCAN RATE as desired for the wear test. Tip velocity equals SCAN SIZE  
times twice the SCAN RATE. Set NUMBER OF SAMPLES for the desired resolution; it 
determines the number of scan lines made during the test.

Note: Keep SCAN RATE; SCAN SIZE; NUMBER OF SAMPLES; INTEGRAL GAIN; 
PROPORTIONAL GAIN, and SETPOINT fixed across all wear tests being 
compared.

8. Increase the DEFLECTION SETPOINT to achieve the desired applied force and immediately 
select Frame > UP or Frame > DOWN from the RealTime menu. As soon as the 
DEFLECTION SETPOINT is increased sufficiently, the tip returns to the surface and starts 
scratching.

Note: The applied force also depends on the free-air vertical deflection, which is set 
to zero with the ZERO SETPOINT parameter (see Basic Force Mode: page 50). 
In general, cantilever deflection equals DEFLECTION SETPOINT minus the free-
air VERTICAL DEFLECTION, in volts. VERTICAL DEFLECTION is displayed on 
the MultiMode base.
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9. Click the WITHDRAW icon (shown) to stop wear scanning, for instance, at the end of a single 
scan,

Note: If you choose to image the worn area after changing probes, take note of large 
nearby features for guidance in positioning the new tip over the worn area. The 
indentation probe may yield a low resolution image if the tip has picked up 
debris while scratching. First image with the indentation probe scanning in the 
same direction as wearing was performed to minimize the additional spread of 
debris. Increase the TappingMode AMPLITUDE SETPOINT while still tracking 
the surface and increase INTEGRAL GAIN to enhance image quality.
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Chapter 12   Additional Signal Access
The PicoForce Force Spectroscopy Control Module provides access to some intermediate signals 
between the NanoScope Controller and the MultiMode which otherwise require a Signal Access 
Module (type I or III) to observe. In addition, a Signal Access Module may be used to input or 
output other waveforms to a MultiMode PicoForce system, so the more general method of signal 
access is described next, and the specific capabilities of the Control Module follow.

12.1 Introduction to Signal Access Modules

A Signal Access Module (SAM) enables monitoring of NanoScope SPM signals that are otherwise 
“internal.” In addition, external signals can be introduced to the SPM for control or processing by 
connecting the signal sources through a SAM, also known as a breakout box.

The SAMIII (see Figure 12.1a) is the full-function SAM described next in this chapter. SAMIII 
interfaces twenty-five SPM signals and ten Application Module signals. Toggle switches enable 
switching each line separately between a normal, uninterrupted configuration and an external input 
signal. Output BNC connectors permit monitoring of both conditioned and uninterrupted signals.

SAM(I) provides the Top Panel functions of SAMIII (see Figure 12.1b) for access to the SPM, but 
not to Application Modules. For the Side Panel functions of SAMIII (see Figure 12.1c) in a 
separate module, access with its focus on Application Modules, there is the Signal Access Module 
Interface to Application Mode (SAM-I-AM). Each SAM is also detailed separately: SAMIII, 
Support Note 332; NanoScope SAM—Description & Use, Support Note 210; NanoScope SAM-I-
AM, Support Note 285.

Figure 12.1a   Signal Access Module III; Labelling of Panels
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Figure 12.1b   SAMIII: Top Panel, Access to SPM Signals

Figure 12.1c   SAMIII: Side Panel, Access to Application Module Signals

12.2 Signals Available through SAMIII

Signal connectors are divided into five groups (see Figure 12.1a for top and side panel definitions):

• Low Voltage Inputs to NanoScope Controller (data signals)                      Top Panel

• Low Voltage Outputs from NanoScope Controller (control signals)                    (see 

• High Voltage Outputs from NanoScope Controller (piezo drive signals)       Figure 12.1b)

• Low Voltage Inputs to Application Module                Side Panel

• Low Voltage Outputs from Application Module          (see  Figure 12.1c)
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The individual pairs of input and output signal connectors in the first three groups (above), those 
located on the top panel, are tabulated in Table 12.2a. In the bottom row, X and Y refer to scan 
position (i.e., MultiMode sample motion). Z refers to probe position with respect to the sample 
plane. A bar over a signal indicates the signal inverse (i.e., a sign change).

Table 12.2a   The Array of BNC Connectors as Labelled on the Top Panel of SAMIII

Signal power limits are specified for SAM connections in Table 12.2b.

CAUTION: The X, Y and Z High Voltage Output (see Table 12.2b) signals are used to drive 
the piezoelectric elements in scanners and can be as large 220V. Observe the 
explicit precautions emphasized in detailed documentation of SAM (either 
SAMIII, Support Note 332; NanoScope SAM—Description & Use, Support Note 
210 or Access to Intermediate NanoScope IV Signals in The NanoScope IV 
Controller Manual).

Table 12.2b   Signal Access Module Connector Ratings

Low Voltage Inputs to NanoScope Controller (Data Signals)

In0 AuxA AuxB AuxC AuxD Zmod —

Low Voltage Outputs from NanoScope Controller (Control Signals)

A B C D D0 D1 —

Ana1 Ana2 (LV) Ana3 Ana4 Bias LVZ —

High Voltage Outputs from NanoScope Controller (Piezo Drive Signals)

X Y Z Ana2 (HV)

ACCESS SIGNAL MAX. VOLTAGE MAX. CURRENT SIGNAL TYPE

SPM In0 ± 10 VDC 10 mA Analog Input

SPM AuxA ± 10 VDC 10 mA Analog Input

SPM AuxB ± 10 VDC 10 mA Analog Input

SPM AuxC ± 10 VDC 10 mA Analog Input

SPM AuxD ± 10 VDC 10 mA Analog Input

SPM Zmod ± 10 VDC 10 mA Analog Input

SPM A ± 5 VDC 500 mA Open Collector Logic (OCL)

SPM B ± 5 VDC 500 mA OCL Output

SPM C ± 5 VDC 500 mA OCL Output

SPM D ± 5 VDC 500 mA OCL Output

SPM D0 ± 5 VDC n/a Transistor-Transistor Logic (TTL)

SPM D1 ± 5 VDC n/a TTL Output

SPM Ana1 ± 10 VDC 10 mA Analog Output

SPM Ana2 ± 12 VDC 10 mA Analog Output

X Y Z
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SAMIII is always connected, either directly or indirectly, to an SPM via a D-37 type cable attached 
to SAMIII through the connector labelled MICROSCOPE. SAMIII is always connected, either 
directly or indirectly, to an SPM controller via another D-37 type cable attached to SAMIII through 
the connector labelled NANOSCOPE CONTROLLER.

Different signals are available depending on whether SAMIII is inserted in the system along the 
path of Cable A, B or C (see Figure 3.2f with its Options 1-3). Table 12.2c lists the available signals 
with SAMIII at each of the three cable positions with an extended MultiMode and Extender in 
Contact Mode operation. Table 12.2d lists SAMIII-accessible signals in an identical system 
configuration (i.e. Option 2), but operated in TappingMode. Table 12.2e and Table 12.2f provide 
the corresponding information for an extended MultiMode with Quadrex (i.e., Option 3) operating 
in Contact and TappingMode respectively.

Note: In terms of signals available via SAMIII, Option 1, with the NanoScope IV 
Controller (and no Cable C), is a subset of Option 3 (i.e., with SAMIII in the 
Cable A and B paths) because Quadrex is included in the NSIV Controller.

Note: “Filtered Deflection” is the signal used by the Thermal Tune algorithm. It is the 
DEFLECTION signal AC coupled and amplified (gain approximately 20).

SPM Ana3 ± 10 VDC 10 mA Analog Output

SPM Ana4 ± 10 VDC 10 mA Analog Output

SPM Bias ± 10 VDC 10 mA Analog Output

SPM LV Z ± 12 VDC 10 mA Analog Output

SPM X ± 220 VDC 70 mA High Voltage Output

SPM X ± 220 VDC 70 mA High Voltage Output

SPM Y ± 220 VDC 70 mA High Voltage Output

SPM Y ± 220 VDC 70 mA High Voltage Output

SPM Z ± 220 VDC 70 mA High Voltage Output

SPM Z ± 220 VDC 70 mA High Voltage Output

SPM Ana2 (HV) ± 220 VDC 70 mA High Voltage Output

App. Mod. OUT-AC ± 10 VDC 10 mA Analog Input

App. Mod. OUT -DC1 ± 10 VDC 10 mA Analog Input

App. Mod. OUT-DC2 ± 10 VDC 10 mA Analog Input

App. Mod. OUT-DC3 ± 10 VDC 10 mA Analog Input

App. Mod. SIG1 ± 10 VDC 10 mA Analog Output

App. Mod. SIG2 ± 10 VDC 10 mA Analog Output

App. Mod. SIG3 ± 10 VDC 10 mA Analog Output

App. Mod. SIG4 ± 10 VDC 10 mA Analog Output

App. Mod. SIG5 ± 10 VDC 10 mA Analog Output

App. Mod. SIG6 ± 10 VDC 10 mA Analog Output

General +15 VDC — 500 mA Power Supply

General -15 VDC — 500 mA Power Supply

General + 5VDC — 500 mA Power Supply

ACCESS SIGNAL MAX. VOLTAGE MAX. CURRENT SIGNAL TYPE
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Table 12.2c   Intermediate Signals: Contact Mode, MultiMode PicoForce System with Extender

Table 12.2d   Intermediate Signals: TappingMode, MultiMode PicoForce System with Extender

Table 12.2e   Intermediate Signals: Contact Mode, MultiMode PicoForce System with Quadrex

Table 12.2f   Intermediate Signals: TappingMode, MultiMode PicoForce System with Quadrex

Note: The signal names shown highlighted in Table 12.2c through Table 12.2f are 
available from the PicoForce Control Module directly, without a SAMIII (see 
the next section).

Signal Cable A Cable B Cable C

IN0 Deflection (1MHz) Deflection (1MHz) Deflection (1.6kHz)

AUX A LFM LFM Handshake

AUX B — Z-sensor Position Z-sensor Position

AUX C — Filtered Deflection Filtered Deflection

AUX D — Mod. LVZ LFM or Mod. LVZ

Signal Cable A Cable B Cable C

IN0 Amplitude (1MHz) Amplitude (1MHz) RMS Amplitude

AUX A LFM LFM Handshake

AUX B — Z-sensor Position Z-sensor Position

AUX C — Filtered Deflection Filtered Deflection

AUX D — Mod. LVZ Phase or TM Deflection

Signal Cable A Cable B Cable C

IN0 Deflection (1MHz) Deflection (1MHz) Deflection (10kHz) Minus Setpoint

AUX A LFM LFM LFM

AUX B — Z-sensor Position Z-sensor Position

AUX C — Filtered Deflection Filtered Deflection

AUX D — Mod. LVZ Mod. LVZ

Signal Cable A Cable B Cable C

IN0 Deflection (1MHz) Deflection (1MHz) RMS Amplitude

AUX A LFM LFM Handshake

AUX B — Z-sensor Position Z-sensor Position

AUX C — Filtered Deflection Filtered Deflection

AUX D — Mod. LVZ Phase or TM Deflection
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Note: Refer to the first three columns of any of Table 12.2c through Table 12.2f for 
PicoForce operation with an NSIV Controller (Option 1 in Hardware 
Configuration, page 13).

12.3 Signals Available via the PicoForce Control Module

The front panel BNC connections of the PicoForce Force Spectroscopy Control Module (see Figure 
5.1a) provide some “internal” signals otherwise only accessible via a signal access module such as 
SAM or SAMIII. Table 12.3a maps PicoForce Control Module front panel connectors to their 
signals.

Table 12.3a   MultiMode PicoForce Control Module Output Signal Access

Front Panel BNC Signal Description

Deflection Output Deflection (1MHz) Unfiltered cantilever deflection signal

Sensor Output Z-sensor Position Probe tip location, to/from sample

Modified LV Output Mod. LVZ The LVZ signal from the NanoScope
controller plus the PicoAngler/User Input 
offset.

Manual Offset Output (with 
switch on ANGLER OUTPUT)

Knob offset The offset to Z-axis actuation supplied by 
turning the PicoAngler Z-position knob

MANUAL OFFSET OUTPUT 
(with switch on USER INPUT)

Whatever is present on the 
MANUAL OFFSET INPUT 
BNC.

You may input a signal and observe it. 
Input signals should conform to the ratings 
specified in Table 5.1a.
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Chapter 13   Maintenance and Support
13.1 System Maintenance

Refer to the Maintenance chapter of the MultiMode Scanning Probe Microscope Instruction 
Manual for MultiMode-specific issues.

MultiMode PicoForce does not require periodic maintenance if always operated at a room 
temperature comfortable to the operator.

13.2 Troubleshooting: General

Additional troubleshooting tips particular to the MultiMode SPM subsystem can be found in the 
MultiMode Scanning Probe Microscopy Instruction Manual.

13.2.1 Fuses and Power Supply

If there is any indication of a lack of power to the instrument, especially failure of the top left light 
on the front panel of the PicoForce Control Module to illuminate when power is turned on, a fuse 
may be blown. Two numbered fuses are located toward the left of the back panel of the PicoForce 
Control Module (see Figure 5.2a). To replace a fuse, complete the following:

1. Toggle the POWER switch OFF, and unplug the PicoForce Control Module.

2. Replace any blown fuse(s) with the proper replacement as indicated in the table below and to 
the right of the fuses, and reproduced in Table 13.2a.

Note: Type “T” indicates time delay, equivalent to “Slow Blow.”

CAUTION: Do not obstruct the cooling fans in the PicoForce Force Spectroscopy 
Control Module, nor in the NanoScope Controller (whether NSIIIa, 
NSIV(a) or NSV)
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Table 13.2a   PicoForce Control Module Fuse Ratings

Note: The appropriate fuse depends on the supply voltage in use: 100V, 120V or 
240V. The maximum power drawn by the PicoForce Control Module as a 
function of supply voltage is listed in a table on the back panel of the module 
(see Figure 5.2a, page 28) and reproduced in Table 13.2b.

Table 13.2b   AC Input Power Factors (Voltage and Current): Three Options

3. Reconnect Module power and toggle the POWER switch ON.

13.2.2 No Sensor Signal or Z-Feedback in Force Mode

Make sure the serial communication cable is installed (see Hardware Configuration,  page 13, 
and Figure 3.2f, cable “D”). If you are using an NSIV Controller, make sure the PicoForce Sensor 
Module Jumper (dongle) is connected to the SENSOR MOD. connector on the back of the NSIV (see 
Hardware Configuration,  page 13). If you are using a Quadrex Module with an NSIIIA 
Controller, make sure the PicoForce Sensor Module Jumper (dongle) is connected to the 
APPLICATIONS MODULES. connector on the back of the Quadrex Module (see Hardware 
Configuration,  page 13).

13.3 Troubleshooting: Pulling Applications

13.3.1 MultiMode Sum Signal Goes to Zero During a Force Plot

The Sum display on the base of the MultiMode measures the intensity of the reflected laser light 
falling on all four quadrants of the photodetector. A high Sum signal is the criterion for laser 
alignment initially in preparing the optical lever for use with a given installed probe. Loss of the 
Sum signal indicates either an unsecured probe in the probeholder, a cantilever deflection so large 

Fuse 100V 120V 240V

1 800mA 800mA 400mA

2 800mA 800mA 400mA

ALL FUSES: 250V TYPE “T” SLOW BLOW

Voltage Current Frequency

100VAC 700mA

50 - 60 Hz120VAC 600mA

240VAC 300mA
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that the reflected laser beam falls outside the photodetector or a damaged probe, possibly due to one 
of the first two causes going undetected.

13.3.2 Probe Tip Stuck to Sample Surface

A low spring constant cantilever tapping in air can get stuck in the thin water layer on a sample 
surface as detected by its tapping amplitude dropping to zero suddenly upon reaching the surface. 
While a higher DRIVE AMPLITUDE may free the tip, at least a higher AMPLITUDE SETPOINT, if not 
a higher DRIVE AMPLITUDE is needed to keep the tip from getting stuck again. The higher impact 
force may not be acceptable either to the sample if it is fragile or to the tip if the sample is 
particularly hard. A stiffer cantilever may be necessary to resist the pull of the water.

Low spring constant contact mode probes may encounter the same difficulty: excessive cantilever 
deflection (more than the DEFLECTION SETPOINT) required to lift the probe off the sample surface. 
Switching probes is simplest for standard silicon nitride probes (Model NP) where the same 
substrate supports two V-shaped probes, one 200µm long and a stiffer one at half the length.

13.3.3 Deflection Signal Clipped at Top of Plot

If the deflection signal goes offscale (the top plot of three in Force Mode, see Figure 8.4a for 
RealTime Mode or Figure 9.0c for Image Processing Mode), it may be just as it appears: the 
cantilever is deflected beyond the range of the photodetector. The photodetector range, governed by 
the parameter DEFLECTION LIMIT, can, on an NanoScope IIIa controller, be set to either of two 
values: 20V or 2.5V. The DEFLECTION LIMIT range for a NanoScope IV(a) is 0V -20V. The 
DEFLECTION LIMIT range for a NanoScope V is 4.096V - 24.58V. Deflections are typically 
more restricted while imaging, so a smaller DEFLECTION LIMIT value is preferred in imaging 
because the same precision applied to a smaller range yields higher resolution. In Force Mode, 
larger deflections are expected and lower resolution is tolerated. Check that in switching from 
imaging to Force Mode, the Scan View > Other Tab > DEFLECTION LIMIT was not left at the lower 
value.

Another possible source of an offscale deflection signal plot is the choice of plot scaling employed.

1. Click in the plot to open the functions menu (see Figure 8.4c).

2. Click SCALE to open the Scale panel (see Figure 13.3a).

3. For manual scaling, make sure AUTO SCALE is not checked and enter a value for Vertical 
Axis RANGE and a selection for Center of Range to accommodate the full range of the 
deflection signal.

CAUTION: If a relative trigger has been set and the photodetector is not 
accurately recording cantilever deflection, the probe may be driven 
into the sample without being triggered to stop.

Stop the force plot by clicking the WITHDRAW icon (shown) or by 
manually retracting the tip by turning The Angler knob 
counterclockwise.
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4. And, for the simplest resolution of the problem: check AUTO SCALE.

Figure 13.3a   The Scale Panel

13.3.4 Problems with Thermal Tune

Baseline Not Flat

If the baseline is not flat, adjust the photodetector until the vertical deflection is approximately 0 V.

Sharp Noise Spike at 20 kHz

If there is a sharp noise spike near 20 kHZ, adjust the photodetector until the vertical deflection is 
approximately 0 V.

Sharp Noise Spike at 15 kHz

A sharp noise spike at approximately 15 kHz sometimes appears if the Sony video monitor that is 
commonly provided with he OMV option is turned on.Turn off the Sony monitor before clicking 
GET DATA.

13.4 Troubleshooting: Pushing Applications

13.4.1 No Sign of Indentation or Scratch

The force needed to deform a surface increases as the tip becomes duller (as a result of wear). To 
increase the force applied during pushing applications, increase the TRIGGER THRESHOLD in 
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0.05V (for scratching) or 0.1V to 0.2V increments (for indenting). Generally, a TRIGGER 
THRESHOLD < 0.2V is insufficient to leave a trace, while a TRIGGER THRESHOLD of 1.0V is 
sufficient. Indentations and scratches should be visible imaged with a SCAN SIZE between 1 and 
3UM.

13.4.2 Contaminated Indentation Probe

All pushing applications have the potential to produce debris, some of which may become attached 
to the tip. A debris-encrusted tip can create irregularly shaped dents, may require higher force to 
achieve the same pressure as a sharper tip and reduces imaging resolution. Comparing image 
resolution of a site before and after pushing provides a good indication of tip contamination during 
pushing.

To clean an indentation tip, perform several indentations at the same location, limiting the 
TRIGGER THRESHOLD to 0.5V on hard samples (such as Diamond-Like Carbon, DLC) or to 2V 
on soft samples (such as the 1um pitch grating gold sample provided). If these actions fail to 
improve image resolution, refer to the troubleshooting section of Support Note 225, 
Nanoindentation and Nanoscratching with SPMs for NanoScope Version 4.32 Software for more 
forceful measures.
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13.5 Thermal Tune Filter Calibration

13.5.1 Purpose

The PicoForce Thermal Tune Filter Calibration procedure is done to set the Filter Gain in the 
NanoScope Controller into alignment with the Picoforce Controller. This procedure is needed when 
a new PicoForce system is setup, if PicoForce Controllers are changed, if Extender/Quadrex/NS IV 
are changed, or if the Scanner Calibration file is lost.

Note: Thermal Tune Filter Calibration of NanoScope V Controllers is not discussed 
here and should be performed only by Bruker personnel.

13.5.2 Passband Gain Calibration

Purpose

This procedure connects TappingMode Drive line (Ana 1) to the deflection line (In0) going into the 
PicoForce controller and the In1B line going out of the PicoForce controller using the PicoForce 
Passband Gain Dongle (PPGD) (P/N 468-006-100). When the PPGD is connected between the 
PicoForce controller and the Extender or Quadrex (for NS3a) or the microscope connector of the 
NSIV, the PPGD allows the calibration of the passband gain of the filtered deflection line (In1C) 
relative to the In1B line. The expected FILTER GAIN values are ~20.

Figure 13.5a   PicoForce Passband Gain Dongle (PPGD

Procedure

1. With PicoForce Controller off and Nanoscope Controller off, connect PPGD to the 
PicoForce Controller Nanoscope Input Connector

2. Connect 37 Pin Monster Cable to other end of PPGD. Disconnect the cable to the MultiMode 
Microscope from the back of the Picoforce Controller.
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Figure 13.5b   PicoForce Passband Gain Dongle In Situ

3. Turn on the PicoForce Controller and the NanoScope Controller

Monster Cable

NanoScope Controller Port
on PicoForce Controller

Important:
Microscope Cable
Must be disconnected
from the back of the
PicoForce Controller
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4. Using Version 6 NanoScope software, enter the PicoForce workspace and open the Thermal 
Tune window, shown in Figure 13.5c.

Figure 13.5c   Thermal Tune Window

5. Click TOOLS > RESET CONTROLLER.

6. Enter the Classic mode by pressing CTRL ALT L.
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7. Open the System Debug window, shown in Figure 13.5d, by pressing ALT ~.

Figure 13.5d   System Debug Window

8. Select PicoForce Tests, shown in Figure 13.5e.

Figure 13.5e   PicoForce Test Window
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9. Select Pico Cal, shown in Figure 13.5f.

Figure 13.5f   PicoForce Calibration Window

10. Check the filter parameters:

• FILTER FREQ: 2000 HZ

• FILTER AMPL: 500 MV

• FILTER GAIN: 20

• FILTER LP FREQ: 34573 HZ

• FILTER HP FREQ: 176 HZ

11. Click the CAL. GAIN button in the PicoForce Test Driver window, shown in Figure 13.5e. 
This calculates a new FILTER GAIN.

12. Accept the prompt to place the PPGD. 

13. The NanoScope software will automatically false engage for 30 seconds, after which, it will 
prompt you to accept the newly measure Gain value: RAW DEFLECTION GAIN IS ##.#, USE 
THIS VALUE?

14. Click OK to accept the new GAIN value if it lies between 18 and 22.

15. If the GAIN lies outside this range, click CANCEL and then click CAL. GAIN again.

16. Perform steps 11 through 15 several times to verify that the GAIN does not vary by more than 
±0.1. It is likely that first two measured GAINS differ from subsequent, stable values.
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17. Return to the PicoForce Calibration window, Figure 13.5f, and verify that the FILTER GAIN 
is the value measured in step 14.

18. Leave the Classic mode by pressing CTRL ALT L.

13.5.3 Deflection Gain Calibration

Purpose

This procedure connects the Ana 3 line to the Deflection line (In0) and the In1B line with the 
PicoForce Deflection Gain Dongle (PDGD) (468-006-101).When connected to the microscope side 
of the Extender or Quadrex (for NS3a) or the Microscope Connector of the NSIV, the PDGD allows 
the calibration of the gain on the deflection line relative to the In1B line. The expected ratio is 
approximately 0.8.

Procedure

1. Unplug the PicoForce Passband Gain Dongle (PPGD) (P/N 468-006-100) from the 
PicoForce Controller and the NanoScope Controller.

Figure 13.5g   PicoForce Deflection Gain Dongle (PDGD) (468-006-101)

2. Plug the monster cable into the Extender or Quadrex.
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3. Plug the PicoForce Deflection Gain Dongle (PDGD) (468-006-101) into the Extender, 
Quadrex or NS IV Controller To Microscope cable connector. See Figure 13.5h.

Figure 13.5h   PicoForce Deflection Gain Dongle (PDGD) In Situ 

4. False Engage the microscope: REAL TIME > FALSE ENGAGE. See Figure 13.5i.

Figure 13.5i   False Engage
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5. Set the DEFLECTION SETPOINT to 0V, shown in Figure 13.5j.

Figure 13.5j   DEFLECTION SETPOINT = 0V
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6. Switch to Force Mode and set CHANNEL 1 to DEFLECTION and CHANNEL 2 to Z SENSOR. 
See Figure 13.5k.

Figure 13.5k   Force Mode Window

7. In the Force Mode window, set the PLOT UNITS to VOLTS, the STRIP CHART RATE to 
1000HZ and the STRIP CHART SIZE to 10.0S. See Figure 13.5l.
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Figure 13.5l   Force Mode Tab

8. In the Feedback tab, set the DEFLECTION LIMIT to 20V. See Figure 13.5m.

Figure 13.5m   Feedback: DEFLECTION LIMIT = 20V

9. Enter the Classic mode by pressing CTRL ALT L.
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10. Open the System Debug window, shown in Figure 13.5n, by pressing ALT ~.

Figure 13.5n   System Debug Window

11. Select Registers, shown in Figure 13.5e and set ANA3 to 7AAA, shown in Figure 13.5o

Figure 13.5o   PicoForce Registers Window
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12. Return to the Force Mode and click START in the Strip Chart Controls area. See Figure 
13.5p.

Figure 13.5p   Force Mode Window with Running Strip Charts on Channels 1 and 2.

13. Divide the average value of the Z SENSOR by the average value of the DEFLECTION 
estimated from the Strip Charts and record the absolute value. The absolute value should be 
approximately 1.2. For the example shown in Figure 13.5q, <Z sensor> is -9.5357V and 
<Deflection> is -7.628V giving a ratio of 1.24.
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Figure 13.5q   Running Strip Charts with DEFLECTION on Channel 1 and Z SENSOR on Channel 2

14. Enter the Classic mode by pressing CTRL ALT L.

15. Open the System Debug window, shown in Figure 13.5r, by pressing ALT ~.

Figure 13.5r   System Debug Window
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16. Select PicoForce Tests, shown in Figure 13.5s.

Figure 13.5s   PicoForce Test Window

17. Select Pico Cal, shown in Figure 13.5t. Multiply the FILTER GAIN measured in Step 13 by 
the value in the FILTER GAIN field. Enter this number, typically 22-26, in the FILTER GAIN 
field and click OK.

Figure 13.5t   PicoForce Calibration Window
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18. Leave the Classic mode by pressing CTRL ALT L.

13.6 MultiMode PicoForce Specifications

The key to precise picoscale force measurement is the closed loop Z-axis control of the scanner. 
The key to thermal noise based calibration of a cantilever spring constant is other noise sources 
contributing less Z-position uncertainty than do thermal perturbations.

Additional MultiMode SPM specifications apply and can be found in the MultiMode Scanning 
Probe Microscopy Instruction Manual.

Table 13.6a   MultiMode PicoForce System Characterization

For specification of the signals available through BNC connectors on the front panel of the 
PicoForce Control Module, and appropriate cautions when accessing them, see Table 5.1a, page25, 
and the immediately preceding text.

Parameter Specification

Scan Size in XY greater than 40 µm

Scan Size in Z 20µm

Z-axis nonlinearity less than 0.2%

Deflection Signal Noise: free triangular cantilever 
with 30pN/nm spring constant at room temperature 
in fluid

less than 0.5nm RMS

Input impedance of MANUAL OFFSET USER INPUT 1M¾
MultiMode PicoForce Manual Rev. F



 Index
Numerics
3D Surface Plot Icon 84
A
Add Parameter 64
Advanced Acquisition Port 28
Angler Enable Button 70
Angler Input 70
Angler Output 27
Angler Reset Button 70
Auto Indent Parameter 100, 104
Auto Scratch Parameter 104, 106
B
Back To Parameter 63
Basic Force Mode 47, 50
Breakout Box 111–116
Button

Angler Enable 70
Angler Reset 70
Capture 50, 77
Continuous 50
Quit (Strip Chart Display Mode) 60
Reset (Strip Chart Display Mode) 60
Single 50
Start/Pause (Strip Chart Display Mode) 60
Stop (Basic Force Mode) 50
Withdraw 50
Zero Force 51

C
Cantilever 4, 40
Cantilever Tune 40
Capture Button 50, 77
Channels Tab 57
Component List 11
Contact Area 97
Contact Stiffness 97
Contaminated Tip 121
Rev. F MultiMode Pico
Continuous Button 50
Control Monitor 4
D
Data Type

Deflection 49
Height 49
Z Sensor 49

Deflection Data Type 49
Deflection Output 25
Deflection Sens Parameter 77, 84
Deflection Setpoint Parameter 108
Delay Parameter 63
Delete Parameter 64
Depth Icon 84
Display Monitor 4
E
Edit Port Setup Panel 34
Elastic Modulus 97, 98
End Z Parameter 63
Environmental Requirements 9
Equipment Panel 32
Erase Icon 84
Export 94
Extender Electronics Module 3, 12, 13
External Input Mode 73
F
Feedback Tab 58
Fetch Molecule 64
Filtered Deflection 29, 114
Flatten Icon 84
Fluid Cell 48
Force Plots, Conventional 37
Force Sensitivity 69
Force Spectroscopy 44
Force Tab 57
Force, Inter-Molecular 44
Force Manual 137



Index
Force, Intra-Molecular 44
Functionalizing a Tip 48
Fuses 117
H
Hardness 98
Hardware

Components Listed 11
Head 11
Height Data Type 49
Hooke’s Law 39
I
Icon

Depth 84
Erase 84
Flatten 84
Icon 3D Surface Plot 84
Image 84
Low Pass 84
Median 84
Planefit 84
PSD 84
Roughness 84
Section 84
XY Drift 84

Image Icon 84
Indent Controls Panel 101, 106
Indent Setpoint Parameter 103
Indentation 97, 99, 100
L
Laser Diode 38
Laser, Infrared 38
Linearity, Z-axis 136
Loop Count Parameter 64
Low Pass Icon 84
M
Manual External Input Mode 47
Manual Offset Input 27
Manual Offset Output 27
Markers 84
Median Icon 84
Microscope Select Panel 32
Mode

Basic Force 47, 50
External Input 73
Manual External Input 47
Offline 84
PicoAngler 47
138 MultiMode PicoFo
Scripted Force 47, 61
Strip Chart Display 60

Modified LV Output 26, 73
MultiMode SPM 3
N
NanoMan Option 97
NanoScope Controller 3, 13, 33
Noise 136
Nonlinearity, Z-axis 136
O
Offline Mode 84
Operator Safety

qualified personnel 6
Optical Lever 39
Other Tab 58
P
Parameter

Add 64
Auto Indent 100, 104
Auto Scratch 104, 106
Back To 63
Deflection Sens 77, 84
Deflection Setpoint 108
Delay 63
Delete 64
End Z 63
Indent Setpoint 103
Loop Count 64
Ramp Vel. 63
Run (Script) 64
Segment 62
Segment Type 63
Spring Constant 84
Start Z 63
Strip Chart Rate 60
Strip Chart Size 60
Trigger Threshold 101, 106, 120
X Rotate 101
Z Start 72

PF Vertical Engage Scanner 11
Phase 4
PhaseImaging 13
PicoAngler 12, 13, 68–72
PicoAngler Mode 47
PicoForce Control Module 12, 13, 24
Planefit Icon 84
Poisson’s Ratio 97, 98
rce Manual Rev. F



Index
Power Spectral Density 42
Power Switch 28
Probe 4, 40, 99
Probe Holder 4
Probetip 4
PSD Icon 84
Q
Quadrex 3, 12, 13
Quit (Strip Chart Display Mode) Button 60
R
Ramp Vel. Parameter 63
Raw Deflection 29
Reset (Strip Chart Display Mode) Button 60
Resonant Frequency 99
Roughness Icon 84
Run (Script) Parameter 64
S
Sampling 43, 53
Scanner 11
Scratching 99, 104
Script Tab 61, 62
Scripted Force Mode 47, 61
Section Icon 84
Segment Parameter 62
Segment Type Parameter 63
Sensor Module Jumper 12, 118
Sensor Output 26
Serial Port Configuration Panel 34
Shear Modulus 97, 98
Signal Access Module 111–116
Single Button 50
Specifications 136
Spring Constant 39–44, 99
Spring Constant Parameter 84
Start Z Parameter 63
Start/Pause (Strip Chart Display Mode) Button 60
Step Sensitivity 69
Stop (Basic Force Mode) Button 50
Strip Chart Display Mode 60
Strip Chart Rate Parameter 60
Strip Chart Size Parameter 60
Substrate 4
Sum Signal 118
Surface Contact Point 103
T
Tab
Rev. F MultiMode Pico
Channels 57
Feedback 58
Force 57
Other 58
Script 61, 62

Thermal Noise 42
Thermal Tune 77
Thermally-limited 38
Tip 4
Tip Factor 40
Titin 45
Translate 52
Trigger Input 26
Trigger Threshold Parameter 101, 106, 120
U
Unloading Stiffness 97
User Input 27
V
Version 6 NanoScope Software 31
Video Optics 13, 58
W
Wear Testing 99, 107
Withdraw Button 50
X
X Rotate Parameter 101
XY Drift Icon 84
Z
Z Sensor Data Type 49
Z Start Parameter 72
Zero Force Button 51
Zoom 55
Z-Position 68
Force Manual 139


	List of Figures vii
	List of Tables xi
	Chapter 1 Introduction 1
	Chapter 2 Safety 5
	Chapter 3 Installation: PicoForce on a New MultiMode System 9
	Chapter 4 Installation: Upgrade to PicoForce 19
	Chapter 5 Hardware Orientation 23
	Chapter 6 Software Orientation 31
	Chapter 7 Pulling: Theory and Principles 37
	Chapter 8 Pulling: Operation 47
	Chapter 9 Pulling: Offline Analysis 83
	Chapter 10 Pushing: Theory and Principles 97
	Chapter 11 Pushing: Operation 99
	Chapter 12 Additional Signal Access 111
	Chapter 13 Maintenance and Support 117
	Index 137
	List of Figures
	Chapter 1 Introduction
	1.1 Overview
	Figure 1.1a PicoForce Control Module, PicoAngler and MultiMode Scanning Probe Microscope (SPM)
	Figure 1.1b MultiMode PicoForce Stretching a Molecule
	Figure 1.1c The Optical Lever Detection Method

	1.2 Scope of this Document
	1.3 Conventions

	List of Tables
	Chapter 2 Safety
	Table 2.0a Safety Symbols Key

	Chapter 3 Installation: PicoForce on a New MultiMode System
	3.1 Unpacking MultiMode PicoForce System Components
	Table 3.1a Environmental Requirements
	Figure 3.1a Packaged PicoForce Option Components: a) Top Layer, b) Bottom Layer

	3.2 System Components
	Figure 3.2a A MultiMode SPM Head
	Figure 3.2b PicoForce Closed Loop Z MultiMode “PF” Vertical Engage Scanner
	Figure 3.2c The MulitMode PicoForce System with Optional OMV Video Optics
	3.2.1 Hardware Configuration
	Figure 3.2d Cable A Between the MultiMode SPM and the PicoForce Control Module
	Figure 3.2e Connectors on the Back Panel of the PicoForce Control Module
	Figure 3.2f MultiMode PicoForce System Interconnection Options
	Table 3.2a Option 1: PicoForce Cabling with NSIV(a) or NSV
	Table 3.2b Option 2: PicoForce Cabling with NSIIIa and Extender
	Table 3.2c Option 3: PicoForce Cabling with NSIIIa and Quadrex
	Figure 3.2g The PicoForce Sensor Module Jumper
	Figure 3.2h Close-Up of Connectors, Back of the NanoScope IV Controller
	Figure 3.2i Close-Up of Connectors, Back of the Quadrex Module


	3.3 Important: Powering Sequence

	Chapter 4 Installation: Upgrade to PicoForce
	4.1 Existing System Component Upgrades
	Figure 4.1a MultiMode PicoForce System Configuration Flow Chart

	4.2 Installation of Upgraded Components
	Table 4.2a MultiMode PicoForce Component Upgrade Processes


	Chapter 5 Hardware Orientation
	Figure 5.0a PicoForce Scanner
	5.1 The PicoForce Control Module Front Panel
	Figure 5.1a The PicoForce Control Module Front Panel
	Table 5.1a Connections to PicoForce Control Module Front Panel External Terminals
	Figure 5.1b Optical Lever Monitoring by Segmented Photodetection

	5.2 The PicoForce Control Module Back Panel
	Figure 5.2a The PicoForce Control Module Back Panel

	5.3 Using the Advanced Acquisition Port
	5.3.1 Connector Pinout
	Table 5.3a Advanced Data Acquisition Port Pins Used to Input to NI DAQ Cards
	Table 5.3b Advanced Data Acquisition Port Pins Used to Output from NI DAQ Cards
	Figure 5.3a Advanced Data Acquisition Port Pin Identification



	Chapter 6 Software Orientation
	6.1 Network Connection
	Figure 6.1a Enabling the Computer Network Card

	6.2 PicoForce Software Configuration
	Figure 6.2a NanoScope Icons, version 6 (left), version 7 (right)
	Figure 6.2b The Microscope Select Panel
	Figure 6.2c System Component Designation
	Figure 6.2d Serial Port Configuration Panel
	Figure 6.2e The Edit Port Setup Panel

	6.3 NanoScope Software Versions 6 and 7

	Chapter 7 Pulling: Theory and Principles
	7.1 Context: Conventional Force Plots
	Figure 7.1a A Traditional Force Plot

	7.2 Sensitivity Enhancements for Force Measurement
	7.3 Spring Constant Calibration
	7.3.1 Estimation from Cantilever Geometry
	Table 7.3a Typical Tip Factor Values

	7.3.2 Adding Mass to the Cantilever
	7.3.3 Measuring Thermal Noise
	7.3.4 Rectangular Cantilever, Hydrodynamic Model

	7.4 Single Molecule Force Spectroscopy
	Figure 7.4a Force Exerted Unfolding a Titin Molecule


	Chapter 8 Pulling: Operation
	8.1 Pulling Modes
	8.2 Tip and Sample Preparation
	8.2.1 Biological Samples
	Figure 8.2a MutiMode (TappingMode, Force Modulation) AFM Fluid Cell

	8.2.2 Functionalizing the Tip

	8.3 Starting a PicoForce Session
	Figure 8.3a NanoScope Icons, version 6 (left), version 7 (right)

	8.4 Basic Force Mode
	Figure 8.4a Force Mode: Channels Tab Featuring Inverted Channel 2 Z-Axis
	Figure 8.4b X Translate Example
	Figure 8.4c Functions Menu: Right Click in Any Displayed Graph
	Figure 8.4d Zoom In on a Force Plot
	Figure 8.4e Selection (Left) and Display (Right) of Force Mode Tab Parameters
	Figure 8.4f Force Mode: Force and Channels Tabs
	Figure 8.4g Force Mode: Feedback and Auto Tabs
	8.4.1 Plotting Deflection versus Tip/Sample Separation
	Figure 8.4h A Deflection vs. Separation Force Plot


	8.5 Strip Chart Display
	Figure 8.5a The Strip Chart Display
	8.5.1 Scripting Mode
	Figure 8.5b Force Mode: Script Tab
	Figure 8.5c Fetch Start
	Figure 8.5d Fetch Molecule Strip Chart
	Figure 8.5e Fetch Script
	Figure 8.5f Script Example

	8.5.2 PicoAngler Mode
	Figure 8.5g The PicoForce PicoAngler

	8.5.3 Switching Between Imaging and Force Modes
	8.5.4 External Input Mode
	8.5.5 Auto Mode
	Figure 8.5h Auto Panel

	8.5.6 Point and Shoot View
	Figure 8.5i Point and Shoot Dialog Box


	8.6 Realtime Analysis
	8.6.1 Determine Deflection Sensitivity in Force Mode
	Figure 8.6a Deflection Sensitivity Determination in Force Mode


	8.7 Determine Cantilever Spring Constant by Thermal Tune
	Figure 8.7a Thermal Tune
	Figure 8.7b Select Thermal Tune Frequency Range
	Figure 8.7c The Thermal Tune Panel
	Figure 8.7d Median Filter Width
	Figure 8.7e Bandwidth for Spring Constant Calculation


	Chapter 9 Pulling: Offline Analysis
	Figure 9.0a Browse for Folder Window Open Upon Clicking Directory
	Figure 9.0b Click an Image on the Right to Open It in the Central Client Window
	Figure 9.0c Offline Presentation of a Captured Force Plot
	9.1 Fitting Force Plots to Models
	Figure 9.1a Hertzian Fit
	Figure 9.1b Worm-Like Chain Fit

	9.2 Reviewing Multiple Force Plots
	Figure 9.2a The Delete Force Curves Window for Reviewing Multiple Force Plot Files

	9.3 Filtering Multiple Force Curves
	Figure 9.3a The Filter Force Curves Window

	9.4 Analyzing Multiple Force Plots
	Figure 9.4a Multiple Force Window
	Figure 9.4b Right-click Menu
	Figure 9.4c Plot Command Menu: Right-Click
	Figure 9.4d Set Increments and Set Offset Menus
	Figure 9.4e MCA: Find Peaks

	9.5 Exporting Force Plot Files
	Figure 9.5a The Data Export Window and (the Beginning of) a Sample Data File


	Chapter 10 Pushing: Theory and Principles
	10.1 Types of Pushing Applications
	10.2 Analysis of Indentation Force Plots

	Chapter 11 Pushing: Operation
	11.1 Probe Selection
	Table 11.1a Probe Characteristics Comparison
	Figure 11.1a A DNISP Type Indenting/Scratching/Wear Testing Probe

	11.2 Indentation
	Figure 11.2a Indent Controls Panel for Indenting
	Figure 11.2b Maintaining the Tip Normal to the Surface During Indentation with X Rotate
	Figure 11.2c X Rotate Effect on Gold Under Constant Trigger Threshold
	Figure 11.2d Shifting the Surface Contact Point Using Indent Setpoint
	Figure 11.2e Example Auto Panel for Automated Indentation

	11.3 Scratching
	Figure 11.3a Nanoscratching
	Figure 11.3b Indent Controls Panel for Scratching
	Figure 11.3c Example Auto Panel for Automated Scratching

	11.4 Wear Testing
	Figure 11.4a Wear Testing in a Rectangular Area


	Chapter 12 Additional Signal Access
	12.1 Introduction to Signal Access Modules
	Figure 12.1a Signal Access Module III; Labelling of Panels
	Figure 12.1b SAMIII: Top Panel, Access to SPM Signals
	Figure 12.1c SAMIII: Side Panel, Access to Application Module Signals

	12.2 Signals Available through SAMIII
	Table 12.2a The Array of BNC Connectors as Labelled on the Top Panel of SAMIII
	Table 12.2b Signal Access Module Connector Ratings
	Table 12.2c Intermediate Signals: Contact Mode, MultiMode PicoForce System with Extender
	Table 12.2d Intermediate Signals: TappingMode, MultiMode PicoForce System with Extender
	Table 12.2e Intermediate Signals: Contact Mode, MultiMode PicoForce System with Quadrex
	Table 12.2f Intermediate Signals: TappingMode, MultiMode PicoForce System with Quadrex

	12.3 Signals Available via the PicoForce Control Module
	Table 12.3a MultiMode PicoForce Control Module Output Signal Access


	Chapter 13 Maintenance and Support
	13.1 System Maintenance
	13.2 Troubleshooting: General
	13.2.1 Fuses and Power Supply
	Table 13.2a PicoForce Control Module Fuse Ratings
	Table 13.2b AC Input Power Factors (Voltage and Current): Three Options

	13.2.2 No Sensor Signal or Z-Feedback in Force Mode

	13.3 Troubleshooting: Pulling Applications
	13.3.1 MultiMode Sum Signal Goes to Zero During a Force Plot
	13.3.2 Probe Tip Stuck to Sample Surface
	13.3.3 Deflection Signal Clipped at Top of Plot
	Figure 13.3a The Scale Panel

	13.3.4 Problems with Thermal Tune

	13.4 Troubleshooting: Pushing Applications
	13.4.1 No Sign of Indentation or Scratch
	13.4.2 Contaminated Indentation Probe

	13.5 Thermal Tune Filter Calibration
	13.5.1 Purpose
	13.5.2 Passband Gain Calibration
	Figure 13.5a PicoForce Passband Gain Dongle (PPGD
	Figure 13.5b PicoForce Passband Gain Dongle In Situ
	Figure 13.5c Thermal Tune Window
	Figure 13.5d System Debug Window
	Figure 13.5e PicoForce Test Window
	Figure 13.5f PicoForce Calibration Window

	13.5.3 Deflection Gain Calibration
	Figure 13.5g PicoForce Deflection Gain Dongle (PDGD) (468-006-101)
	Figure 13.5h PicoForce Deflection Gain Dongle (PDGD) In Situ
	Figure 13.5i False Engage
	Figure 13.5j Deflection setpoint = 0V
	Figure 13.5k Force Mode Window
	Figure 13.5l Force Mode Tab
	Figure 13.5m Feedback: Deflection limit = 20V
	Figure 13.5n System Debug Window
	Figure 13.5o PicoForce Registers Window
	Figure 13.5p Force Mode Window with Running Strip Charts on Channels 1 and 2.
	Figure 13.5q Running Strip Charts with Deflection on Channel 1 and Z sensor on Channel 2
	Figure 13.5r System Debug Window
	Figure 13.5s PicoForce Test Window
	Figure 13.5t PicoForce Calibration Window


	13.6 MultiMode PicoForce Specifications
	Table 13.6a MultiMode PicoForce System Characterization


	Index
	Numerics
	A
	B
	C
	D
	E
	F
	H
	I
	L
	M
	N
	O
	P
	Q
	R
	S
	T
	U
	V
	W
	X
	Z


